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LIMITED WARRANTY AND LIMITATION OF LIABILITY

Each Fluke product is warranted to be free from defects in material and workmanship under normal use 
and service. The warranty period is 1 year and begins on the date of shipment. Parts, product repairs, and 
services are warranted for 90 days. This warranty extends onl y to the original buyer or end-user customer 
of a Fluke authorized reseller, and does not appl y to fuses, d isposable batteries, or to any product which, 
in Fluke's opinion, has been misused, al tered, neglected, contaminated, or damaged by accident or 
abnormal cond it ions of operation or hand l ing. Fluke warrants that software wil l operate substantial l y in 
accordance with its functional specifications for 90 days and that it has been properl y recorded on non-
defective med ia. Fluke does not warrant that software wil l be error free or operate without interruption.

Fluke authorized resellers shall extend this warranty on new and unused products to end-user customers 
onl y but have no authority to extend a greater or d ifferent warranty on behal f of Fluke. Warranty support is 
available onl y if product is purchased through a Fluke authorized sales outlet or Buyer has paid the 
appl icable international price. Fluke reserves the right to invoice Buyer for importation costs of repair/
replacement parts when product purchased in one country is submitted for repair in another country.

Fluke's warranty obl igation is l imited, at Fluke's option, to refund of the purchase price, free of charge 
repair, or replacement of a defective product which is returned to a Fluke authorized service center within 
the warranty period.

To obtain warranty service, contact your nearest Fluke authorized service center to obtain return 
authorization information, then send the product to that service center, with a description of the d ifficul ty, 
postage and insurance prepaid (FOB Destination). Fluke assumes no risk for damage in transit. Fol lowing 
warranty repair, the product wil l be returned to Buyer, transportation prepaid (FOB Destination). If Fluke 
determines that failure was caused by neglect, misuse, contamination, al teration, accident, or abnormal 
cond it ion of operation or hand l ing, includ ing overvol tage failures caused by use outside the product�s 
specified rating, or normal wear and tear of mechanical components, Fluke wil l provide an estimate of 
repair costs and obtain authorization before commencing the work. Following repair, the product wil l be 
returned to the Buyer transportation prepaid and the Buyer wil l be bil led for the repair and return 
transportation charges (FOB Shipping Point).

THIS WARRANTY IS BUYER'S SOLE AND EXCLUSIVE REMEDY AND IS IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. FLUKE SHALL NOT BE LIABLE FOR ANY 
SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSSES, INCLUDING LOSS OF 
DATA, ARISING FROM ANY CAUSE OR THEORY.

Since some countries or states do not al low l imitation of the term of an impl ied warranty, or exclusion or 
l imitation of incidental or consequential damages, the l imitations and exclusions of this warranty may not 
appl y to every buyer. If any provision of this Warranty is held inval id or unenforceable by a court or other 
decision-maker of competent jurisd iction, such hold ing wil l not affect the val id ity or enforceabil ity of any 
other provision.
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End User Software License and Hardware Agreement

CAREFULLY READ THE FOLLOWING AGREEMENT. BY OPENING THE PACKAGE OR CLICKING ON "I 
AGREE", YOU ARE CONSENTING TO BE BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT. 
IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, CLICK "I DO NOT AGREE", DELETE 
ANY DOWNLOADED INSTALLATION FILES, AND, IF APPLICABLE, RETURN THIS PRODUCT TO THE 
PLACE OF PURCHASE FOR A FULL REFUND.

Software License Grant

The package or downloaded installation file contains:

1. I-V Curve Tracer TM PC software (PC Software), 

2. I-V Curve Tracer I-V Measurement Unit software (Embedded Software), and 

3. Related explanatory written materials (Documentation). 

PC Software and Embedded Software includes any upgrades, mod ified versions, updates, add itions, and 
copies of the software. You means the person or company who is being l icensed to use the Software or 
Documentation. We, us, and Fluke Corporation mean Fluke ® Corporation.

We hereby grant you a nonexclusive l icense to use one copy of the PC Software on any single computer, 
provided the PC Software is in use on onl y one computer at any t ime. The PC Software is in use on a 
computer when it is loaded into temporary memory (RAM) or instal led into the permanent memory of a 
computer-for example, a hard d isk, CD-ROM or other storage device. If the PC Software is permanentl y 
instal led on the hard d isk or other storage device of a computer (other than a network server) and one 
person uses that computer more than 80 % of the time, then that person may also use the PC Software on 
a portable or home computer.

We hereby grant you a nonexclusive l icense to use one copy of the Embedded Software when it is running 
within the relevant Sol metric hard ware. 

Software Titl e

Fluke remains the owner of al l right, t itle and interest in the PC Software, Embedded Software, and 
Documentation. 

Archival or Backup Copies of PC Software

You may either:

� make one copy of the PC Software solely for backup or archival purposes, or

� transfer the PC Software to a single hard disk, provided you keep the original solely for backup or 

archival purposes.



Things You May Not Do With the Software or Documentat ion

The PC Software, Embedded Software, and Documentation are protected by United States copyright 
laws and international treaties. You must treat the PC Software, Embedded Software, and Documentation 
l ike any other copyrighted material--for example a book. You may not:

� copy the Embedded Software

� copy the PC Software except to make archival or backup copies as provided above,

� modify or adapt the PC Software or Embedded Software or merge it into another program,

� reverse engineer, disassemble, decompile or make any attempt to discover the source code of the 

PC Software or Embedded Software,

� place the PC Software or Embedded Software onto a server so that it is accessible via a public 

network such as the Internet, or

� sublicense, rent, lease, or lend any portion of the PC Software, Embedded Software, or 

Documentation.

Transfers of PC Software or Embed d ed Software

You may transfer al l your rights to use the PC Software and Documentation to another person or legal 
entity provided you transfer this Agreement, the PC Software, and Documentation, includ ing al l copies, 
updates and prior versions to such person or entity and that you retain no copies, includ ing copies stored 
on computer.

You may transfer al l your rights to use the Embedded Software and Documentation to another person or 
legal entity provided you transfer this Agreement, the hard ware associated with the Embedded Software, 
and the Embedded Software and Documentation, includ ing all copies, updates and prior versions to such 
person or entity and that you retain no copies, includ ing copies stored on computer.
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Introduction

This document covers the Solmetric I-V Curve Tracer kit which includes the PV-1500HE2 and 

PV1500T2 (I-V Curve Tracer), SolSensor-300V3 (SolSensor), and the I-V Curve Tracer 

application software (PVA Software or the Software).

The I-V Curve Tracer is a portable electrical test instrument that commissions and 

troubleshoots PV arrays. The I-V Curve Tracer measures the current-voltage (I-V) curves of PV 

(Photovoltaic) modules and strings and immediately compares the results to the predictions of 

built-in PV models. Measurement results are saved for future reference and analysis. The I-V 

Curve Tracer and SolSensor are controlled wirelessly by a Tablet or a Notebook PC. This 

wireless feature lets a user work in the immediate work area without trip hazards associated 

with hard-wired interconnections. 

Note

Unless otherwise noted, this manual uses PC to refer to either a laptop or a tablet.

The I-V Curve Tracer makes the electrical measurement of the I-V curve, while the SolSensor 

simultaneously measures the irradiance, PV module temperature, and array tilt.

The I-V curve of a PV module, string, harness, or array provides a detailed description of its 

energy-conversion ability. The curve nominally ranges from the short circuit current (Isc) at 0 V 

to the open circuit voltage (Voc) at zero current. At the knee of a normal I-V curve are the 

maximum power current and voltage (Imp, Vmp), the point at which the array generates the 

maximum electrical power at the present irradiance and temperature. These important 

voltages and currents are captured when the I-V curve is measured. The detailed shape of the 

curve between these points gives additional information about the health of the PV module, 

string, or array under test. 
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To increase the insight gained, the measured I-V curve is compared to predictions of key 

points with a comprehensive PV model. The model takes into account:

 the PV module specifications

 the number of modules in series and strings in parallel

 the losses in system wiring

 the irradiance in the plane of the array

 the module temperature, and array orientation

The Software has a powerful Array Navigator tool with a graphical array tree used to save and 

recall measurement data. The New Project Wizard guides a user through the set up of the PV 

model and customization of the array tree for each project.

The Software also saves insulation resistance data collected by a separate insulation 

resistance tester. This data is stored and managed with the same type of array tree touch 

interface (with a tablet) as the I-V measurement results.

Note 

Go to the Product page at www.fluke.com to download any current software updates, 

manual supplements, or revised manuals. Compare the posted version or revision 

numbers with the versions that the user has. To find the current software version, from 

your software, select Help>About. To update, download the latest version and run the 

installer. The Software is free. The latest software supports all the Fluke and Solmetric 

1500V I-V curve tracers. 

Contact Fluke

Fluke Corporation operates worldwide. For local contact information, go to our website: 

www.fluke.com.

To register your product, or to view, print, or download the latest manual or manual 

supplement, go to our website.

+1-425-446-5500

fluke-info@fluke.com 

Safety Information

General Safety Information is in the printed Safety Information document that ships with the 

I-V Curve Tracer and at www.fluke.com. More specific safety information is listed where 

applicable.

A Warning identifies hazardous conditions and procedures that are dangerous to the user. A 

Caution identifies conditions and procedures that can cause damage to the Product or the 

equipment under test.

https://www.fluke.com
www.fluke.com
www.fluke.com
mail:fluke-info@fluke.com
fluke-info@fluke.com
mail:info@flukecal.com
www.fluke.com
www.fluke.com
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WCaution

To avoid Product damage:

 Do not expose the PVA to >1500 V or >30 A.

 Before you measure in a combiner box, make sure to:

 Open the dc disconnect switch to electrically isolate the combiner box from 

other combiners and the inverter. Use a voltmeter to double check that the 

combiner is isolated.

 Remove all string fuses except for the string(s) under test. Multiple strings can 

be tested in parallel if their combined current is <30 A.

 Electrically isolate the string(s) under test when you measure at an inverter.

 Observe the 30 A limit when you measure strings in parallel in harness circuits.

 Limit strings of high-efficiency modules to <10 A when you use the PVA 

1500V4/T.

Specifications

Complete Product specifications are available at www.fluke.com. Safety specifications are in 

the Safety Information that shipped with the product.

PC Minimum System Requirements

Systems that do not meet the subsequent requirements might not operate as anticipated. A 

Microsoft Windows laptop or touch sensitive tablet works well. Tablets tend to be more rugged 

than laptops in the field. 

Fluke recommends:

 A touchscreen device for best productivity

 A laptop that can be used as a tablet 

 A screen with good contrast in bright sun

 Anti-glare screen surface

 Good view angle so multiple people can see the screen

The PC should have:

 Microsoft Windows 11,10, 8, or 7 (32-bit or 64-bit versions)

 Wi-Fi

 Display resolution of 1024 X 600 (minimum)

www.fluke.com
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 Processor Speed of >1 GHz (1.5 GHz recommended). Fluke recommends a Windows 

Experience Index (Processor component) of 2.3 or greater. This value is available from the 

PC Control Panel under Performance Information and Tools.

 RAM: 4 GB minimum (8 GB recommended)

 Available disc space: 100 Mb or more

Equipment

The I-V Curve Tracer ships with: 

Curve Tracer Equipment

 The I-V Curve Tracer - in its soft case, with a complete set of Fluke-provided gear either in 

its accessory pouch or transit case. Check for PVA test leads and PV connector tools. 

 Soft case

 AC wall plug charger

 1500 V rated test leads for PV-1500HE2: banana jack to MC-4 and banana jack to alligator 

clips. For other PVA models: MC-4 to alligator clips 

 MC-4 connector tool

 Printed Safety Information 

 Printed Getting Started

 Transit case (included with PVA-1500HE2 only) 

SolSensor Equipment 

 SolSensor unit

 K-type thermocouple temperature sensors (2) 

 Soft case (unless I-V Curve Tracer kit was purchased with the transit case option) 

 Module frame clamp

  AC wall adapter with dual USB-A outputs for charging the IV Unit and the SolSensor

 Adhesive discs for thermocouple attachment (50). Discs of high-temperature tape to 

attach the tip of the thermocouple to the module backside

 SolSensor tool lanyard to secure SolSensor to the racking

 Supplies to clean the irradiance sensor (micro-fiber cloth and distilled water spray)
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The main parts of the I-V Curve Tracer Kit are is shown in Table 1 and Table 2.

Table 1. SolSensor

Item Description

A Irradiance Sensor Cover

B Irradiance Sensor

C Ears

D LED Power Button 

E T1- Thermocouple 1 input

F Battery charge input

G T2- Thermocouple 2 input

H Auxiliary input

A

C

D
E F

G H

C

B
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Table 2. I-V Curve Tracers

Item Description

A Negative Input

B Positive Input

C Battery Charger Input

D LED Power Button

A

A B

B

CD

PVA-1500HE2 PVA-1500/T2

C
D
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System Controls and Settings

Use the LED button on the I-V Curve Tracer and SolSensor, see Figure 1, to enable, pause, and 

reset the I-V devices. The LED indicates various operational states of the devices and the 

status of the wireless network. See Table 3.

Table 3. Operational States of the I-V Curve Tracer and SolSensor LED Button

I-V Curve 

Tracer
SolSensor LED Behavior Device State Button Behavior

X X Off Off Push 1x to turn on

X - Slow flash

Paused. I-V Curve Tracer 

turns off automatically in 

15 minutes to conserve 

the battery.

Push once to enable 

measurements or 3x 

to turn off the I-V 

Curve Tracer.

X X Flash
No Wi-Fi or connection to 

the Software.
Push 3x to turn off.

X X Rapid Flash
Starting up or Error (if 

continuous).
-

X X Steady on
Connected to Software, 

measurements enabled.

Push once to pause (I-

V Unit) or 3x to turn 

off.

X X - Any state Push 3x to turn off.

X X
Five flashes, 

pause, repeat
Device attempts to pair.

To pair devices: push 

5x in rapid succession.

X X

Slow Flash or 

Steady on when 

plugged in and 

no connection to 

Software.

Flash indicates a 

charging battery. Steady 

on indicates battery is 

fully charged.

-
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When you push the LED button once to turn on the I-V Curve Tracer or SolSensor, the LED 

flashes rapidly as it starts, then flashes slower until the device connects with the PC Wi-Fi and 

Software. Once it connects to the Software, the LED is steady on.    

Before you connect the I-V Curve Tracer test leads to the PV circuit, push the LED button on 

the I-V unit once to pause measurements. This prevents an accidental trigger of a 

measurement as you make connections. While in this paused state, the LED flashes with long 

pauses to show that the I-V Curve Tracer is on and paused.

After connections are made to the test leads, push the button once to enable the I-V Curve 

Tracer to make measurements under control of the Software. The LED stays steadily lit, to 

indicate that the I-V Curve Tracer is ready to take measurements. 

If the network connection is lost, the LED flashes to indicate the lost connection to the 

Software. 

Note 

If the I-V Curve Tracer or SolSensor is plugged in to the AC charge adapter and 

connected to the Software, the LED button indicates the connected/disconnected 

state (solid or flashing LED), not the charging/charged state.

The I-V Curve Tracer and SolSensor are uniquely paired at the factory. If they need to be paired 

again:

1. Push the I-V Curve Tracer LED button five times in rapid succession to initiate re-pairing.

2. Wait until the I-V Curve Tracer LED button begins to flash in groups of five, then push the 

SolSensor LED button five times in rapid succession. Both LEDs flash in groups of five until 

pairing occurs. 

When necessary to reset either the I-V Curve Tracer or the SolSensor, hold the LED button 

down for at least 6 seconds and release.

Power Up the I-V Curve Tracer

To power up the I-V Curve Tracer, push the power button once, see Figure 1. 

If a network is not established within 15 minutes, the I-V Curve Tracer turns off to conserve the 

battery. In normal use, the I-V Curve Tracer does not go into sleep mode when the LED is 

steady on. However, if placed into the Pause mode, the I-V Curve Tracer enters sleep mode 

15 minutes after placed in Pause. To use Pause, push the power button (in Pause mode the 

LED flashes briefly every 3 seconds).
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Test Leads and Clips

The included test leads and clips are specifically provided for use with the Product. These 

leads and clips are specially rated for use at voltages up to 1500 V and 30A dc. See Table 4.

Operating temperature and humidity of the test leads and clips are more narrowly specified 

than the PVA-1500HE2 and SolSensor. For details see PVA-1500 Test Lead and Clip 

Specifications. See Specifications.

XWWarning 

To prevent possible electrical shock, fire, personal injury, or death: 

 Read all safety information before you use the test leads.

 Only use the PVA-1500 series test leads and clips on the Photovoltaic (PV) solar 

modules and arrays.

 Only use with isolated (ungrounded) PV circuits.

 For protection from hot surfaces, do not remove the enclosure from the canvas 

case. The I-V Curve Tracer dissipates stored energy in the form of heat in normal 

operation.

 Remove circuit power before you connect the I-V Curve Tracer to the circuit. For 

example, when you test in a PV combiner box, open the disconnect switch and lift 

all the fuses before you attach the test leads and clips. 

 Do not handle the test leads and clips while they are energized by the source 

circuit. 

Table 4. Test Leads

Number Description

A PVA-1500S/V2/V3/V4/T MC-4 to alligator clip

B PVA-1500HE2 banana jack to alligator clip

C banana jack to gold-plated MC-4

A     B              C
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Cover the Irradiance Sensor

When not in use, always keep the irradiance sensor (see Figure 1) covered with the supplied 

black rubber cover. Remove the cover after you mount SolSensor in the plane of the array, and 

replace the cover again before you move SolSensor to another location. 

The white acrylic eye of the irradiance sensor is a precision optical element which must be 

kept in like new condition to assure accurate measurements. It is easily damaged by impact 

or abrasion, and its accuracy is also compromised by soiling. Keep the cover on when not in 

use. 

Installation

This section describes the I-V Curve Tracer installation procedure. 

WCaution

If either the I-V Curve Tracer or SolSensor are dropped, Fluke recommends that 

the Product(s) be sent back to Fluke for examination.

Installation Procedure

Hardware Installation

Before operation, make sure the I-V Curve Tracer and SolSensor batteries are fully charged. 

Refer to Charge the Battery. 

Software Installation

To install the Software:

1. Download the Software from www.fluke.com.

2. After the download, if the software welcome screen does not automatically open, run the 

installer.

3. Follow the on-screen instructions to install the Software

4. During installation, if a Windows update dialog appears, connect the PC to the Internet to 

download any required Windows prerequisites.

5. After you start the installation and/or install the Windows updates, the installation 

location screen appears. The default location is provided. 

6. When installation completes, the final setup wizard screen appears. If the Run I-V Curve 

Tracer box is selected, click Finish to launch the Software. Alternately, click Finish and 

then double-click on the shortcut icon on the desktop to start the Software.
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When the initialization completes and the Software launches, the Software shows the main 

screen. See Table 7.

At installation, the Software creates the directory structure in the Documents directory. 

Update the PV Equipment Databases

If connected to the Internet when the Software starts, the Software checks if the updated PV 

module equipment databases are available from Fluke.

Charge the Battery

Charge the I-V Curve Tracer Battery

Note

The I-V Curve Tracer battery is not removable. 

To recharge the battery: 

1. Connect the battery charger to the connector on the I-V Curve Tracer, see Figure 1.

2. Plug the charger into an ac outlet and plug the USB end of the charger cable into the ac 

charger adapter. 

The LED button flashes to indicate that the I-V Curve Tracer battery is charging. The LED 

glows solid when the battery is completely charged. 

Figure 1. I-V Curve Tracer Battery Charger Connector (PVA-1500HE2 Shown)

The battery can take 6 hours to charge. Charge the battery each night before use in the field. 

Charger/Chargeur                                                Press On/Off

      5VDC, 1A                      Made in USA             

PVA-1500HE

PV Analyzer
1500V 30A
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The Software interface warns when the battery level is low. To manually check the battery 

voltage level, click the Status area (above the Measure Now button) on the screen or select 

Battery Level from the Utility menu. Make sure the I-V Curve Tracer has been on and 

connected to the software for at least 30 seconds before the battery level check. 

Charge SolSensor 

Note

The SolSensor battery is not removable. 

To recharge the battery:

1. Attach the battery charger cable to the charge connector, see Figure 2.

2. Plug the ac charger adapter into an ac outlet and plug the USB end of the charger cable into 

the ac charger adapter.

Figure 2. Connected SolSensor Charger

The battery can take 6 hours to charge. Charge the battery each night before use in the field.  

As SolSensor charges, the LED button flashes. When the battery charge completes, the LED 

button glows solid. 

Note

If SolSensor is plugged in and connected to the Software, the LED button indicates the 

connected state (solid LED), not the charging/charged state.

To check the battery voltage level, click the Status area (above the Measure Now button) in the 

Software after an I-V measurement or select Battery Level in the Utility menu.
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The Wireless Network

Communication between the PC and the I-V Curve Tracer is by conventional Wi-Fi. When the 

I-V Curve Tracer is on, the I-V Curve Tracer creates a hotspot. Locate that hotspot in the PC 

network list and connect to that network. The SSID (hotspot name) has the format 

pva1500_nnnnnn where nnnnnn is the unique identifier of the I-V Curve Tracer.

SolSensor automatically links to the I-V Curve Tracer when both are turned on. All 

communications between the PC and SolSensor are relayed through the I-V Curve Tracer. 

To see a diagram of the wireless network, select the network icon at the lower left of any 

screen in the Software (  ). 

The I-V Curve Tracer and SolSensor come from the factory paired to each another. A 

SolSensor can only be paired to one unique I-V Curve Tracer at a time. To pair a different I-V 

Curve Tracer, see Set Up the I-V Curve Tracer. When a SolSensor is paired to a I-V Curve 

Tracer, it forgets any previous pairing. 

Because the PC connects with the I-V Curve Tracer Wi-Fi, the built-in Wi-Fi interface is not 

available to simultaneously connect to other networks or devices. To avoid this limitation, add 

a USB Wi-Fi adapter as the second network interface.

When you use the I-V Curve Tracer, and the Wi-Fi link to the I-V Curve Tracer hotspot 

temporarily drops, the PC attempts to automatically connect to another network in your list 

that is set to connect automatically. To avoid this, in the network list on the PC, check the 

connect automatically box for the I-V Curve Tracer hotspot, and uncheck connect 

automatically for other networks.

Set Up and Use the I-V Curve Tracer and SolSensor 

Set Up the I-V Curve Tracer

To set up the I-V Curve Tracer:

1. Put the I-V Curve Tracer near the PV circuits under test.

2. Connect alligator clip leads, if necessary. Use only clip leads supplied with the I-V Curve 

Tracer and rated for at least the maximum current and voltage of the I-V Curve Tracer.

3. You can make extension cables if the I-V Curve Tracer cannot be located near the circuit 

under test. When extension cables longer than 10 ft (one-way) are added between the 

circuit under test and the I-V Curve Tracer, route the cables parallel next to each other to 

minimize the inductance they add to the circuit.
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Set Up SolSensor 

WCaution

To avoid damage to SolSensor:

 Cover the irradiance sensor with the protective cap whenever it is not mounted 

and in use. SolSensor contains a sensitive irradiance measurement device that 

can be damaged by impact or abrasion. To preserve sensor accuracy, do not soil 

the irradiance sensor. See Clean the SolSensor Irradiance Sensor.

Figure 3 shows SolSensor mounted on the frame of a PV module.

Figure 3. SolSensor Mounted on Frame of a PV Module

Mount SolSensor to a PV Module Frame

Figure 4 shows SolSensor attached to a PV module with the Module Frame Clamp and 

secured with the tool lanyard. 

Note

If you mount SolSensor along the upper horizontal edge of the module, you can 

achieve better irradiance accuracy earlier and later in the day. 

Ear

Ear

TC1
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Figure 4. SolSensor Tool Lanyard Secured to a Racking Member

To mount SolSensor:

1. Place SolSensor against the top horizontal leg of the module frame, with its metal posts 

and ears seated against the frame surfaces, as shown in Figure 3.

2. As you hold SolSensor in that position, slip the tip of the Module Frame Clamp inside the 

frame of the module. Seat the tip of the clamp on the flat inner surface of the frame as 

shown in the inset of Figure 4 and not on a shelf or ridge from which it could slip and allow 

SolSensor to come loose. Make sure to not impact or scratch the backside of the module 

with the foot of the clamp.

3. Squeeze the clamp mechanism until SolSensor is firmly held against the side of the module 

frame. 

4. Inspect the mount and make sure that the posts and ears are in contact with the upper 

edge of the module frame. If there is space under one or both of the ears, the irradiance 

sensor will not be in the plane of the array as necessary. Loosen the clamp slightly, 

reposition SolSensor, and re-tighten the clamp. If the SolSensor is mounted high in the air 

(for example, on a carport array), Fluke recommends the use of the lanyard as a back up in 

case the SolSensor comes lose from the clamp. Attach the tool lanyard to an eyelet on 

SolSensor. Then loop the lanyard around a racking member and clip it back on itself, as 

shown in Figure 4.
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5. Unwind a thermocouple and straighten the lead. Avoid kinks in the lead. Connect the 

thermocouple to SolSensor. Insert the yellow plug of the thermocouple wire into the upper 

left yellow receptacle labeled TC1, see Figure 3. 

6. Straighten the last few inches of the thermocouple lead. The tiny ball at the end is where 

temperature is measured.

7. Tape the tip of the thermocouple into firm contact with the backside of the module, far 

enough under the module to avoid the cooler outer edges. When you test single, free-

standing modules, attach the thermocouple tip as shown in Figure 5. For accurate 

temperature measurements, use a wide piece of high temperature polyester tape. Fluke 

recommends the use of the adhesive discs provided with the Product. Other types of tape 

sag at high temperatures which allow the tip of the thermocouple to pull away from the 

backsheet of the module. Use firm pressure to roll the tape over the thermocouple tip to 

force the tip into solid contact with the module backside. 

A second thermocouple can be added with the TC2 input on the SolSensor. When you use 

two thermocouples, Fluke recommends they be attached in different locations on the 

module or on a second module. 

Figure 5. Locate the Thermocouple Tip on a Single Free-Standing Module

8. Remove the protective cover from the SolSensor irradiance sensor. 

9. Push the LED button to turn on SolSensor. The LED flashes as it attempts wireless 

connection, and glows steadily when the connection is made, see Figure 1. SolSensor 

links to the I-V Curve Tracer, which relays its communications with the PC.  

2/3

1/3
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Optimize Wireless Transmission Range

Follow these practices for best SolSensor transmission range.

 Locate SolSensor for best line-of-sight to the I-V Curve Tracer, which acts as a relay 

station between SolSensor and the PC.

 Avoid locations where the signal must transmit through buildings or trucks, or through 

many rows of PV modules and racking.

 Avoid placement of SolSensor directly on a metal surface such as a metal roof or HVAC 

box, as this reduces range. If you mount SolSensor on the end of a torque tube of a single-

axis tracker, it may give a better range if you first mount SolSensor to a short bar, and then 

mount the bar to the torque tube.

Transmission range can sometimes be increased when you locate SolSensor on the top frame 

edge of a top-row module, or near the end of an array where there is better line of sight to 

where the I-V Curve Tracer is set up. 

If it is not possible to achieve the necessary transmission range with the above methods, 

mount SolSensor on a tripod and orient it to the correct azimuth and tilt. Choose a location that 

has sky exposure similar to the array itself.

Mount SolSensor on a Tripod

For greater flexibility and for potentially better wireless range, mount SolSensor to a tripod. 

This is also useful when it is not feasible to access the array. 

Use this equipment to deploy SolSensor on a tripod (contact Fluke for specific equipment 

recommendations):

 Sturdy tripod

 Tripod level indicator

This is typically a disc with a bubble level that mounts between the tripod and the rest of the 

fittings described here. Some tripods have a built-in level indicator. 

Note

Level indicators vary widely in their sensitivity and accuracy.

 Tripod leveling head - Quickly creates a level mounting surface, without the need to adjust 

the tripod legs. 

 Panning unit -Rotates about the vertical axis, and lets you adjust the azimuth of SolSensor 

independent of the tilt.
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 Tilt unit - Rotates on a horizontal axis, and lets you set the tilt independent of the azimuth. 

Typically, you will mount the tilt unit on the panning unit, which is in turn mounted on the 

leveling indicator and the leveling unit and the tripod.

 Adapter plate - Firmly attach this plate to the bottom of SolSensor and to the top of the tilt 

unit.

These instructions assume that you use a tripod leveling unit. If not, adjust the tripod legs to 

level the tripod mounting surface.

Note

Irradiance measurement accuracy depends upon correct orientation of SolSensor. 

You must follow the steps in the order listed, to keep the tilt and azimuth adjustments 

independent of one another. 

To properly deploy SolSensor on a tripod setup: 

1. Assemble SolSensor and the tripod-related hardware as shown in Figure 6.

Figure 6. Tripod Mount Setup
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2. Consider these factors when you choose a tripod location:

 Location should have an open view of the sky, similar to the array itself. Avoid locations 

where trees or structures obscure parts of the sky, especially on cloudy days where 

diffuse light makes up a significant part of total irradiance. Avoid locations that have 

substantial albedo effects (reflections). 

 Location should have good line of sight to the combiner boxes or other locations where 

the PC is to be used. 

 To use thermocouples to measure the backside of the module temperature, locate the 

tripod close enough to a sub-array that you can attach the tip of the thermocouple well 

under the modules, away from the cooler outer edges of the array. A thermocouple 

extension cable can be useful. Contact Fluke for recommendations. 

3. Fully spread the tripod legs and seat them firmly. 

4. Connect the thermocouple wire to SolSensor and attach the thermocouple tip to the 

backside of a PV module. Do not attach the thermocouple near the edges of the module, 

which are cooler. Alternatively, omit the thermocouple(s) and set the software to derive the 

cell temperature from the I-V curve.

5. If averaging the readings of two thermocouples, also deploy the second thermocouple. If a 

second thermocouple is used, but not attached to a module (for example, if it is used to 

measure the ambient temperature) then do not use SmartTemp or average as the 

temperature method. 

6. Adjust the leveling unit to center the bubble, and lock the leveling unit. 

7. Rotate the panning unit to orient SolSensor to the same azimuth (compass heading) as the 

array under test, then lock the panning unit. Be sure to adjust your compass for the local 

magnetic declination. A magnetic declination calculator is available at http://

www.ngdc.noaa.gov/geomag-web/?id=declinationFormId. To avoid distortion from earth�s 

magnetic field by components in SolSensor or the tripod mounting hardware, separate the 

compass horizontally from SolSensor. Insert a non-ferrous rectangular spacer. 

8. Rotate the tilt unit until the tilt angle indicated in the Software matches the actual tilt of the 

PV array, and then lock the tilt unit. 

Connect to the Solar PV Equipment

Installed PV systems vary in design and construction. Therefore, the guidance provided in this 

section is general in nature, and it is critical that you apply techniques and precautions 

appropriate to the circumstances. Follow best PV/electrical safety precautions. 

Note

The subsequent procedure, while important, does not cover all situations. Assess the 

potential dangers of each PV system, and take appropriate precautions. 

http://www.ngdc.noaa.gov/geomag-web/?id=declinationFormId
http://www.ngdc.noaa.gov/geomag-web/?id=declinationFormId


PVA-1500HE2/PVA-1500T2/SolSensor-300V3

Users Manual

20

To connect to the Solar PV equipment:

1. Isolate the PV module string to be tested (test string) from the inverter and from other 

strings in the array. To make the measurement at a fused dc combiner box, isolate the 

combiner box by means of a dc disconnect switch, and pull the fuses to isolate the PV 

strings from one another.

2. To make the measurement at a string inverter if the strings run directly to the inverter, pull 

the series fuses to isolate the strings from one another and from the inverter input circuits.

3. Push the button on the I-V Curve Tracer to disable the I-V sweep.

XWWarning

To prevent possible electrical shock, fire, personal injury, or death, know that PV 

circuits continue to present danger of electrical shock while the I-V Curve Tracer 

is paused. 

4. Use safe operation procedures to connect the PV leads of the I-V Curve Tracer to the PV 

source to be measured. Make the connection at the PV module, at the ends of home-run 

cables, at a combiner box at the inverter. Connect the PVA test leads to the string to be 

measured. In some cases, you can attach the alligator clips to the bus bars in a combiner 

box (see Figure 7) or to the fuse clips in an inverter. 

Figure 7. I-V Curve Tracer Test Leads Clipped to the Buss Bars of a PV Combiner Box
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5. If the distance between the circuit under test and I-V Curve Tracer requires the use of 

extension cables, use a properly-rated PV cable for the maximum system voltage, with 

correctly installed connectors. Select a wire gauge that results in a suitably small voltage 

drop.

When extension cables longer than 10 ft (one-way) are added between the circuit under 

test and the I-V Curve Tracer, widely space the cables to minimize the inductance they add 

to the circuit.

6. If you connect at a fused combiner box, for best results Fluke recommends you insert only 

one string at a time. Some combiner boxes have one fuse per string while others have two 

fuses per string (one on the positive side and another on the negative side). If you test a 

combiner with two fuses per string, then leave all of the fuses on the negative side inserted 

and insert one fuse on the positive side at a time. Multiple strings can be measured at the 

same time in parallel as long as the total current does not exceed the rating of the I-V Curve 

Tracer. 

7. Push the button on the I-V Curve Tracer to un-pause and enable the I-V sweep.

I-V Measurements

The I-V Curve Tracer measures an I-V curve each time you click the Measure Now button in 

the Software. I-V data transmits to the PC shortly after the I-V Curve Tracer takes each I-V 

sweep. Data is not stored in the I-V Curve Tracer itself after transmission to the PC. The Voc 

measurement is done the instant before the I-V sweep begins.

Sweep Disabled

PV current stops automatically at the end of each I-V measurement. However, before you 

connect or disconnect test leads or cables, push the I-V Curve Tracer power button to pause 

the measurement sequence. Manually disabling the I-V Curve Tracer in this way ensures that 

the I-V Curve Tracer does not make an unexpected I-V measurement. When ready to take 

another measurement, push the power button again.

XWWarning

To prevent possible electrical shock, fire, personal injury, do not connect or disconnect 

the PV leads if the LED on the I-V Curve Tracer is solid on. 
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Over-Temperature Protection

Built-in safeguards prevent I-V Curve Tracer operation at potentially damaging internal 

temperatures.

The I-V Curve Tracer absorbs energy with each measurement, and across a series of 

measurements the internal temperature of the I-V Curve Tracer gradually increases. Some of 

this accumulated heat is shed between measurements and as the equipment is moved around 

the site between measurement sessions. If, on average, the heat gain exceeds the heat loss 

and the internal temperature continues to rise, the internal temperature sensor triggers. When 

that happens, the I-V Curve Tracer shuts down to cool the instrument, and the Software posts 

the Disabled message in the Status indicator, directly above the Measure Now button.

WCaution

To avoid I-V Curve Tracer damage, locate the I-V Curve Tracer in the shade to 

reduce the likelihood of thermal shutdown. If possible, do not place the I-V Curve 

Tracer on an asphalt driveway, solar panel, or roof in direct sunlight.

Sweep-to-Sweep Delay and Thermal Capacity

To manage the internal temperature of the I-V Curve Tracer, there is a sweep-to-sweep delay 

that limits how quickly a subsequent I-V sweep can be made. The delay varies and depends on 

the Voc measured as shown in Table 5.

The thermal capacity of the I-V Curve Tracer is the number of I-V measurements that can be 

made before the maximum allowable internal temperature is reached and an extended cool off 

period is required. Thermal capacity decreases with higher Voc, higher outdoor ambient 

temperatures, and shorter wait time between measurements. For a reference PV system with 

16 strings per combiner box and string Voc of 1300 V, if you measure the 16 strings one after 

another followed by 5 minutes of no measurements (for example, while you move to the next 

combiner box), then the thermal capacity is as shown in Table 6 for two different Sweep-to-

Sweep Delay scenarios and two different ambient temperatures.

Table 5. Sweep-to-Sweep Delay

Voc Sweep-to-Sweep Delay

≤200 V 6 seconds

201 V to1000 V 6 seconds

1001 V to1350 V 8 seconds

>1350 V 11 seconds
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After the I-V Curve Tracer reaches the thermal capacity, a message appears and further 

measurements are not allowed. Every minute of cooling (for example, no measurements) 

increases the number of subsequent measurements allowed before thermal capacity is 

reached again. Keep the I-V Curve Tracer out of the sun and/or move it to an air conditioned 

environment to help increase the recovery rate. 

XWWarning

For protection from hot surfaces, do not remove the enclosure from the canvas 

case. The Product dissipates stored energy in the form of heat in normal 

operation.

High-Temperature Condition Operation

The most demanding thermal conditions for the I-V Curve Tracer are:

 Hot day

 No wind

 No shade

 High open circuit voltage

 I-V sweeps taken in rapid sequence

If these conditions are expected, plan ahead to minimize temperature rise in the I-V Curve 

Tracer. Shade the I-V Curve Tracer from direct sunlight, elevate it above hot surfaces, and 

allow more time between I-V sweeps.

Table 6. Thermal Capacity (Number of I-V Measurements Before Extended Cool-Down) 

Sweep-to-Sweep Delay # Measurements Before Thermal Shutdown

18 seconds
unlimited (77 oF ambient)

550 (113 oF ambient)

9 seconds
unlimited (77 oF ambient)

330 (113 oF ambient)
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Over-Voltage Warnings

Over-voltage Condition

WCaution

To prevent I-V Curve Tracer damage, do not let the open-circuit voltage of the PV 

source under test exceed the specified maximum dc input voltage of the I-V Curve 

Tracer. The Product can be damaged and require factory repairs. Over-voltage 

can occur if the PV system dc voltage is higher than expected or two strings are 

accidentally wired in series.

If a PV voltage >1525 V is detected, an over-voltage warning shows in the Software. Reduce 

the PV voltage before you continue to make measurements. If a PV voltage >1550 V is 

detected, the I-V Curve Tracer internally disables itself to prevent further measurements and a 

warning is posted to return the unit to Fluke for inspection and repair of possible internal 

damage. 

Over-Current Warnings

WCaution

To prevent I-V Curve Tracer damage, do not expose the I-V Curve Tracer to 

current in excess of its specified dc input current. Damage may occur to the I-V 

Curve Tracer and require a return to the factory for repair. A warning message 

shows when excess current is applied to the unit.

Over-current can occur when:

 Too many strings in parallel are measured.

 When you measure strings that are still electrically connected to the rest of the array or the 

inverter (for example, when the combiner box dc disconnect is not opened).

 When you use a PVA-1500T2 and you measure a string of high efficiency (≥19 %) PV 

modules with a current >10 A. 

High-efficiency modules produce a short but intense pulse of current at the start of every I-V 

curve measurement. PVA-1500HE2 tolerates this in-rush current for strings of high-efficiency 

modules with Isc up to 30 A, however the PVA-1500T2 is limited to strings of high-efficiency 

modules with Isc ≤10 A. See Measure High-efficiency Modules.
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Reverse Polarity or Zero Volts Detection

If the I-V Curve Tracer detects a voltage <-0.5 V, the Software posts the Negative Voltage 

Detected warning, an internal-protection circuit prevents internal damage, and no I-V 

measurement occurs. It is likely that the I-V Curve Tracer is connected with the wrong polarity 

across a circuit. 

If the I-V Curve Tracer measures a voltage between -0.5 V and 0.5 V the Software posts the 

0 volts detected warning and no I-V measurement occurs. It is likely that the I-V Curve Tracer 

is not connected to the circuit, the circuit has an open, or for some other reason, the circuit has 

close to 0 V.

Software Overview

Projects

The PVA Software stores all setup information and measurement results in a specialized file 

type called a Project file. The Software guides you through steps to create a Project for a 

particular array. 

All PV modules within a Project must be of the same type and must be mounted at the same 

azimuth. Often a site has multiple PV arrays with a mix of different modules and azimuths. To 

accommodate these differences, create a separate Project for each case. To save time, copy 

and paste your first Project file, rename it, and edit only the features that are different.

The Software has a special feature to measure the performance of strings in horizontal single-

axis tracking systems. The Software can automatically flip, at solar noon, from a morning 

azimuth to an afternoon azimuth. SolSensor reports the tilt with each measurement.

Note

Consider the creation of multiple Projects to preserve software responsiveness for 

large PV sites. For example, in a 50 MW project, create a separate Project for each pad 

or each inverter. This improves the speed of the Data Analysis Tool used to analyze 

your data. 
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Note

Make sure that the PC is set to the correct date and time, and that the time zone and 

daylight savings setting are correct. The Software uses these parameters to calculate 

the position of the sun at the exact moment of the I-V curve measurement. This allows 

the Software to calculate the angle of incidence of the direct sunlight and use that 

information to optimize the accuracy of the irradiance sensor and the PV model. Errors 

in these settings introduce errors in the effective irradiance measurement and in the 

predicted performance of the PV modules under test and, as a result, will also cause 

errors in the Performance Factor (measured maximum power / predicted maximum 

power). Verifying the correct settings is especially important if you travel between time 

zones with your equipment.

I-V measurements are automatically stamped with the date and time at the instant of the 

measurement. 

If the PC is connected to the Internet, each time you open the New Project Wizard, the 

Software checks a web time server for the correct Universal Time and adjusts the PC clock as 

needed. Choose the time zone and daylight savings setting. 

All dates and times associated with the saved measurement data are preserved even if the 

Project is subsequently opened in another time zone.

System Tree

When you create a new project, you are walked through a process of creating a tree 

representation of the system being measured. This is called the System Tree. After each I-V 

curve measurement is made, the Software shows the System Tree, and you will touch or click 

the tree to tell the Software where you took the measurement in the array. This allows the PV 

model to retrieve wiring characteristics and other details that are unique to that location, and 

tells the Software where to save the measurement result. The predictive model points (Isc, 

Pmax, and Voc) are shown on the I-V curve graph only after you have identified the location of 

the measurement. 
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Main Screen Overview

The Software is fully touch-enabled. The main screen is shown with the Traces tab selected in 

Table 7.

Table 7.  Software Main Screen

Item Description

A The Tabs provide different ways to view the data.

B Current (A) - Current scale along the vertical axis on the left of the graph.

C

Measurement ID - The label above the graph identifies the displayed I-V trace. If 

you have not assigned or saved the trace, the ID shows only the date and time at 

which the measurement was taken.

If you have assigned the trace to a location in the System Tree but not yet saved it, 

the ID shows the date, time, and location in the System Tree and indicates that the 

data has not been saved.

If you have assigned and saved the trace, the ID shows the date, time, and location 

in the System Tree.

Also shown in the measurement ID is a link that shows the time offset from GMT. 

Click on the link to check the time zone. 
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Item Description

D

Status Indicator - The status indicator in the upper right of the Software screen 

shows the various messages below. Click on the status indicator to see more 

information about the active status.

 Ready - Indicates that the I-V Unit is ready to take a fresh I-V measurement.

 Searching for I-V Unit - Indicates that the Software is trying to connect to the 

I-V Unit. This status should change to Ready within seconds after you connect 

your PC to the I-V Curve Tracer Wi-Fi hot spot. If there is a problem, it is typically 

because they are out of wireless range of one another, or you connected with a 

different I-V Unit that was in the same vicinity (uncommon).

 Measuring - Indicates that an I-V measurement is in process.

 Paused - Indicates that the I-V Curve Tracer is in the paused state. In this state, 

PV source connections may be changed without interrupting a measurement.

 Disabled - Indicates that I-V measurements are disabled due to a problem. 

Problems could be related to low battery, over current, over voltage, over 

temperature, reversed polarity, and so on. No measurements can be taken in 

this state. Click on the indicator for more information.

E
Measure Now - Click here to make an I-V measurement. This button is disabled 

when the Status is anything other than Ready. 

F

Assign and Save/Reassign - Before the PV model points for a new measurement 

can be shown on the I-V graph, the measurement must be assigned or saved to a 

location in the System Tree in the Array Navigator. This allows the model to read 

information necessary from the tree, such as the number of PV modules in a string, 

and the wiring characteristics. 

To save and assign:

1. After a fresh measurement, the I-V curve shows, and the System Tree is 

temporarily shown alongside. 

2. Click the location in the System Tree at which the measurement was taken. 

Then use the Assign and Save button at the bottom of the dialog box to save 

your data to that location. If you want the model points to appear but do not 

want to save the trace, click Assign. 

After a measurement is saved, the Assign and Save button becomes the Reassign 

button. Click Reassign if you accidentally saved a measurement to the wrong 

location in the System Tree. When the tree shows, click the correct location and 

click Assign and Save at the bottom of the dialog box. The location changes and 

the Measurement ID above the I-V curve shows the new location.

Table 7.  Software Main Screen (cont.)
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Item Description

G
Recall... - Recalls measurement data from the System Tree. When the tree appears, 

click the location in the array tree that contains the desired data. If more than one 

measurement is stored at that location, select by Date/Time.

H

SolSensor Display Area - If SolSensor is turned on and within wireless range, its 

real-time sensor values are shown in the lower right of the screen. 

If the SolSensor is turned off or out of wireless range of the I-V Curve Tracer, 

Searching for SolSensor appears in this area. 

If two thermocouples are connected to SolSensor, both temperatures appear. 

However, it is most common to use only a single thermocouple.

If a PV model and a Project have not yet been created, the irradiance value shown   

is a preliminary value and the value shows in a gray, italic font as discussed in 

Preliminary vs. Effective Irradiance and shown here:

Once a Project is loaded, irradiance shows in a black, regular font.

I Voltage (V) - Voltage scale along the horizontal axis of the graph.

J

Measurement Summary Bar - Located below the displayed I-V curve, the 

Measurement Summary Bar shows the results of the currently displayed 

measurement.

The Performance Factor represents the measured maximum power value as a 

percentage of the value predicted by the PV model.

The Fill Factor (FF) is an indication of the squareness of the I-V curve and is 

discussed in detail in Interpret Measured I-V Curves.

The irradiance, temperature, and tilt measured at the instant that the I-V curve.

(Not 

Shown) 

Power (W) - Displays the power scale along the vertical axis on the right of the 

graph when the P-V curve is selected in the View menu. The current and power 

axes auto-scale independently. As a result, the relative heights of the I-V and P-V 

curves change when auto-scaling occurs. 

Table 7.  Software Main Screen (cont.)
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Menu Bar

File Menu

Click File to access the File menu. Use the File menu to create, load, and export Projects. 

The File menu has these choices:

 New Project...

See New Project.

 Browse Project...

Access previously-saved Projects for retrieval.

 Recent Projects

Access to recent Projects.

 Export Trace for Active Measurement...

Exports the measurement results for the measurement currently shown in the Traces 

screen, as a csv (comma separated value) file.

 Export Traces for Entire System...

Exports the measurement results for the currently loaded Project as a Windows folder tree. 

The tree is organized in a hierarchy, for example, System\Inverter\Combiner\String IV Data 

(csv files). Only the last measurement result for each location in the array is exported.

Data in this hierarchical format can be analyzed automatically by the Data Analysis Tool.

 Export Insulation Resistance Test Data...

Exports the insulation test data as a csv file for the currently-loaded project. Insulation test 

data must be collected with a separate insulation resistance meter and entered by the user 

into the Software.

New Project

To make a new project:

1. Click File>New Project� This starts the new Project wizard beginning with the Site Info 

screen.

2. In the Site Info screen, enter the Latitude, Longitude, Array Type, Array Azimuth (True), and 

the Project time. You can also use the Lookup City button to substitute the latitude and 

longitude of a city near the PV installation.
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The Site Info screen has a special feature for horizontal single-axis tracking systems, which 

allows the I-V curves to be taken as the tracker works. This has the advantage of taking all 

of the measurements at the greatest possible irradiance level. Enter the morning azimuth 

of the array (and at solar noon the Software adds 180 degrees for the afternoon azimuth). 

Figure 8 shows the array type and azimuth settings for a horizontal single-axis tracker. In 

this example, the PV modules face east in the morning (before solar noon). 

To clarify azimuth in a tracker, imagine that the tracker stops at a fixed setting and you want 

to determine the azimuth at which the modules are oriented. Imagine if a marble is placed 

on the module glass surface, near the upper frame element, and you release the marble to 

roll downhill. It rolls down in a straight line, like an arrow, and the projection of that arrow on 

a horizontal surface (typically the ground, if level) is in the direction of the azimuth of the 

module.

Figure 8. Most Common Settings for a Horizontal Single-axis Tracking System

3. Make sure that the PC clock is correctly set. These parameters include the time, date, and 

time zone. 

Note

Each measurement made is stamped with the time, date, and time zone as determined 

from the PC. These values must be correct for the irradiance sensor to correctly 

interpret the irradiance, and for the Software to correctly calculate the Performance 

Factor. The time, date, and time zone cannot be corrected after the measurements are 

taken. It is important to make sure these values are correct before you start to take 

measurements.

The date/time stamp is determined from the PC that controls the I-V curve 

measurement process, not the PC on which the PVA project file was originally created 

(which is sometimes different if, for example, the project file is created in an office on 

one PC and then the project is sent to a different PC for making measurements). 

When the user launches the Software at the PV system site for a day of measurements, 

check the PC clock first to make sure that the date, time, and time zone are correct.

4. When the Site Info screen is complete, click Next to advance to the PV module screen.
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Select the PV Module

Select the PV module to make the module performance parameters available to the Project. 

This allows the Software to calculate the expected I-V curve and the Performance Factor.

To select the PV module:

1. Start to enter the name of the manufacturer, and you are shown a list of similarly-spelled 

items. 

2. Select the name from the generated list. 

3. Repeat the process for the model number of the PV module. If the necessary manufacturer 

or model number is not in the list, click New Custom� and enter the manufacturer, model 

number, and specifications. 

Save the data as a custom module. This custom module is stored as part of the Project so 

that if the project file is shared with another computer, the custom module appears on the 

second computer. 

4. To add that module to the Favorites list, click the star icon. After you have selected the 

model number, the performance parameters for that module show.

5. Review all parameter values. If edits are needed, use the pencil icon buttons to enter the 

correct information. If you edit, you can rename that module and save it in the custom 

equipment folder.

Create the System Tree

When finished with the selection or the edit of the PV module, click Next to advance to the 

Tree Builder screen, see Figure 9.

Figure 9. Array Navigator with Symmetrical Tree Builder
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Use this screen to describe the PV system hardware. Use the information entered here to: 

 Create a visual tree representation of the array that you can touch to save and recall the 

measurement data.

 Specify the # modules per string and wire parameters that the Software model uses to  

predict expected performance.

An example of a finished array tree is shown in Figure 10. For clarity, the names of the layers of 

the tree have been completely spelled out. In practice, abbreviate the names so that the path 

names for the measurements fit in the Software tree displays and headers and in reasonable-

sized spreadsheet cells.

Figure 10. Finished Array Tree

First, use the Symmetrical Tree Builder screen to create the basic structure of the tree. The 

Symmetrical Tree Builder opens with a default System Tree (with 2 inverters, 2 combiner boxes 

per inverter, 2 strings per combiner box, and 1 module per string). Edit these defaults to fit the 

system you will test. If the tree is a large utility-scale project, the design is likely to be modular, 

and in this first screen you describe that modular, symmetric structure that repeats again 

across the field. Then after running the Symmetrical Tree Builder, you use the Array Navigator 

screen, to adjust the array tree and account for any non-symmetrical aspects.

Edit the tree so that it matches the design of your PV field. Change any of these parameters:

 Number of layers in the tree.

 Names of the layers

 The quantity in each layer

 Represent items by number or alphabetically

 Number of modules in each string
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To add a layer to the tree, highlight the next highest layer and select Add Layer Below. To 

delete a layer, highlight the layer and select Delete. A layer can be an inverter, a group, a 

combiner, or a string. Add a combiner layer to represent anything that combines electrical 

circuits. Add a harness when strings are wired in parallel out in the array. Use group layers to 

represent other organizational levels: blocks, parking lots, skids, pads, tracking motor groups, 

and so on.

There are some limitations on which tree elements can be nested under one another. The rules 

are based mainly on the requirement that the PV source under test must ultimately nest 

(directly or indirectly) under an inverter. 

Note

For clarity, rename the layers to agree with the naming conventions used in 

engineering drawings so that there is no confusion about where measurements were 

made.

Try not to use more non-electrical layers than necessary (block, field, parking lot, and 

so on) and abbreviate the names of the layers to keep them as short as possible so 

that the path names for each measurement fit in the display area of the Software, Data 

Analysis Tool, and final report.

In each layer there are editable fields that show white background when the user highlights a 

layer. Use these fields to customize the name of the layer, to change the quantity, to use 

numbers or letters, and in the case of strings, to indicate the number of modules in the string.

When the tree is complete, double-check it against your engineering drawings to be sure it is 

correct because it is inconvenient to change the structure of this basic tree after you exit the 

Symmetrical Tree Builder. 

After you close the Symmetrical Tree Builder, use the edit features of the Array Navigator to 

add or delete items, adjust quantities, copy and paste, move up and down, and so on. Often a 

PV installation includes a smaller PV system to take advantage of remaining space. You can 

add that system at this time.

When you have finished the edits to the structure of your tree, you can edit the string wiring 

properties (wire length and wire gauge) of the array. The wiring properties are used by the I-V 

Curve Tracer model to properly account for those losses. To use the wiring properties 

controls, first select a level of the tree to which you want the changes to apply. The changes 

you make are applied to all strings at or below the level of the tree that you edit.

Note

PV systems usually minimize wiring losses, so it is unnecessary to be exact about the 

wiring characteristics entered. For example, if the strings in a combiner box have one-

way wiring lengths that range from 50 ft to 100 ft, you may just want to assign 75 ft to 

them all. If the entire project has string wiring with that range of length, highlight the top 

level of the tree (System) to make your edit, and the wiring properties are applied to all 

strings in the project.
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You can also highlight a level of the tree and change the number of modules per string for all 

strings at that level and below. 

When you are finished with the creation of your System Tree, click Finish and save your 

Project.

Copy, Modify, and Reuse a Previous Project

To create a new Project that is similar to one you have created before, copy the earlier Project 

and adjust it as needed. 

To modify a previous project:

1. In Windows File Explorer, navigate to the folder that holds your .pvapx Project file. If you are 

not sure where to find the Project file, launch the Software, click File>Browse Project..., 

and you will see the path to the last Project you browsed to or click File>Recent Projects 

to see the last few Projects opened in the Software. 

2. In Windows File Explorer, highlight the Project file within the Project folder and copy and 

paste it. 

3. Rename the copy with the name of your new project.

4. In the PVA Software, click File>Browse Project..., and navigate to the new Project file.

5. Use the screens in the Properties menu to edit the Project as needed. Delete all of the data 

to avoid confusion with any new data. The easiest way to do this is to delete the inverters 

and build a new tree.

Properties Menu

Use the Properties menu to set, view, and edit settings of the currently-loaded Project. These 

menu items access the same screens that appeared in the New Project Wizard. See New 

Project. 

View Menu

Trace view options...

The choices in Figure 11 select which features show in the Traces screen. To show this legend 

at the bottom of the Traces screen, check Show legend under chart. 
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Figure 11. View Menu

Show Insulation Test Tab

Click the check box to show the Insulation Test tab at the left of the measurement screen. 

Utility Menu

The Utility menu provides access to housekeeping functions and miscellaneous tools. The 

Utility menu is described in Table 8.

Table 8. Utility Menu

Menu Item Description

Calibration 

Verification...
See Calibration Verification for a description of this dialog.

Enable Manual 

Sensor 

Configuration

Check this menu item to allow changes to the irradiance, temperature, 

and tilt readings. See Measure Irradiance, Temperature, and Tilt for 

guidance on sensor choices. 
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Menu Item Description

Global Sensor 

Configuration...

Use these controls to change the sources of the irradiance, 

temperature, or tilt readings for all measurements currently saved in the 

project. Select the necessary sensors from the drop-down lists. Create 

a backup file before taking this action. This action cannot be 

undone.   

See Measure Irradiance, Temperature, and Tilt for guidance on sensor 

choices.

Set I-V Curve 

Resolution...

Use to select the number of points in your I-V curve measurements.

 Select 100 points for commissioning and most troubleshooting 

(smaller data files and faster data transfers). 

 Select 500 points for research or more detailed troubleshooting 

applications (larger file sizes and slower data transfer).

Configure 

Measurement Alert 

Thresholds�

Set thresholds that the Software automatically checks after each 

measurement is Assigned and Saved (but not if the measurement is 

only Assigned). Use these alerts to catch problems before you move to 

other circuits or leave the site. 

Battery Level�

Use this option to see the battery voltage levels or click on the Status 

indicator. For accurate battery readings, wait 30 seconds to check the 

battery voltage if you just removed the I-V Curve Tracer from the 

charger or just turned on the I-V Curve Tracer. 

The Software reports the battery levels of both the I-V Curve Tracer and 

SolSensor. 

The I-V Curve Tracer and SolSensor both shut down when the battery 

voltage drops below 3.05 V. A warning shows in the Software before the 

shutdown. 

The type of Lithium ion battery used in these instruments has a square 

discharge curve, so there is relatively slight variation in battery voltage 

from the fully-charged state to the shutdown level.

Capture 

Application 

Screen...

Captures and saves the current screen to an image file.

Table 8. Utility Menu (cont.)
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Help Menu

See Table 9 for a description of the Help menu.

Tab Screens

The tabs along the left edge show measurement data in various ways. Certain elements are 

common to more than one tab. These include the Status indicator, Measure Now, Assign and 

Save..., Reassign..., the wireless sensor displays, and the Environmental Inputs slide-up 

panel. 

Traces Tab

The Traces tab shows the most recent measurement results and the predicted shape of the 

I-V curve (if a PV model is defined). See Table 7 and Table 20.

Select View, then View Options to choose the necessary view:

 I-V curve - The solid red curve shows the measured I-V points transmitted from the I-V 

Curve Tracer. 

 I-V curve prediction markers - The three red dots are the predicted I-V points for the 

short circuit current Isc the maximum power point (Imp, Vmp), and the open circuit voltage 

Voc. 

Table 9. Help Menu

Menu Item Description

Connected 

Measurement 

Devices...

When selected, a figure shows the network diagram, which represents 

your PC, I-V Curve Tracer, SolSensor, and the wireless signal levels 

between them. When you use the I-V Curve Tracer and SolSensor, the 

I-V Curve Tracer relays all communications between the PC and 

SolSensor. Also refer to this screen to find out what firmware version is 

in the I-V Curve Tracer and SolSensor and to check for available 

firmware updates. Have this information ready when you call Fluke for 

product support.

User's Guide... 
Accesses the I-V Curve Tracer Users Manual. Download and print if 

necessary. The manual is also available from the Fluke website.

About...
Shows the Software version number and software build date. Have this 

information ready if you call Fluke for product support.
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 P-V curve - The solid blue curve shows the power versus voltage curve (P-V) available from 

the PV circuit under test (module or string), and is calculated from the I-V curve by 

multiplying I x V for each I-V point. The blue point marks the maximum value on the P-V 

curve (Pmax). This value is calculated by fitting a mathematical curve to the top of the P-V 

curve and then calculating the maximum value of the fitted curve. This reduces the impact 

of electrical noise on measurement accuracy. The location of the blue marker is derived 

from the measured P-V curve and not from the PV model. 

 I-V curve translated to STC.

Table Tab

The Table tab presents summaries of the predicted and measured I-V data and a translation of 

the measurement results to Standard Test Conditions. Table 10 explains the Table screen. 

See Traces Tab for explanations of other controls shown on this screen.

Table 10. Table Tab Description

 Item Description

A Measured Column - Shows most recent measured values.

B Predicted Column - Shows the predicted values from the performance model.

C
Meas Translated to STC Column - Shows the measured parameters translated to 

Standard Test Conditions, 1000W/m2 irradiance and 25 °C cell temperature.

D

Voltage Ratio - The voltage ratio is a relative indication of the slope of the vertical 

leg of the I-V curve. Voltage ratio is defined as Vmp/Voc. See Interpret Measured I-V 

Curves.

A B C

O
N

M
L

K
J

I
H

G
F

E
D
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 Item Description

E

Current Ratio - The current ratio is a relative indication of the slope of the horizontal 

leg of the I-V curve. Current ratio is defined as Imp/Isc. See Interpret Measured I-V 

Curves.

F Tilt - Tilt of array.

G Vmp (V) - Voltage at the maximum power point.

H Imp (A) - Current at the maximum power point.

I

Voc (V) - Open circuit voltage. Voc is measured immediately before the actual I-V 

sweep. This Voc value is accurate even if the measured I-V curve does not extend 

completely down to the horizontal axis. 

J
Cell Temp (oC) - Cell Temperature. This differs from the backside thermocouple 

measurement. A model predicts the temperature drop from the cell to the backside 

to get the cell temperature. 

K

Isc (A) - Short circuit current. The first point of the I-V sweep is slightly to the right of 

the vertical axis of the I-V curve graph. The PVA software draws a horizontal line 

from this point back to the vertical axis.

L Irr (W/m2) - Irradiance. The modeled effective irradiance. 

M Pmax (W) - Measured maximum power.

N
Fill Factor - The Fill Factor (FF) is an indication of the squareness of the I-V curve. 

See Interpret Measured I-V Curves.

O
Performance (%) - The Performance Factor is the ratio of the measured max power 

to the predicted max power. See Interpret Measured I-V Curves.

Table 10. Table Tab Description (cont.)
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History Tab

The History tab automatically accumulates the tabular results of your most recent 

measurements. New results are in the left column. Previous results are shifted to the right. The 

table holds a maximum of 32 results. Once that limit is reached, the oldest measurement result 

drops from the table each time a new measurement is taken. The parameters shown in the 

History tab are identical to the results shown in the Table tab. Additional parameters appear 

when the Show Advanced Parameters box is checked, these are shown in Table 11.

Table 11. History Tab (Advanced Parameters) Description

Item Description

A

Prelim Irr (W/m2) - Preliminary Irradiance. This is the raw irradiance measured from 

the SolSensor. The measurement includes calibration and temperature 

corrections, but does not include the model correction for effective irradiance. 

Compare Preliminary Irradiance to the Modeled Effective Irradiance when there 

appears to be a problem with the Irradiance indication. See Preliminary vs. 

Effective Irradiance.

B

Irr Sensor - Irradiance Sensor input configuration. For example, this could be 

SolSensor, From I-V, or Manual. Enable Manual Sensor Configuration in the Utility 

Menu. See Utility Menu.

C
TC1 (oC) - Thermocouple 1 temperature reading. Look at this to understand the 

SmartTemp value. 

D
TC2 (oC) - Thermocouple 2 temperature reading. Look at this to understand the 

SmartTemp value. 

E

Temp Sensor - Temperature Sensor input configuration. For example, this could 

be SolSensor, TC1, TC1, Avg(TC1, TC2), From I-V, or Manual. Enable Manual 

Sensor Configuration in the Utility Menu. See Utility Menu. Note that this appears 

only when Show advanced parameters is checked.

A

C
D

E

E

B
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The History tab is especially useful to inspect the agreement between measurements taken at 

a combiner box during commissioning tests, and also to see sequential steps in a 

troubleshooting sequence. For example, when you use the Selective Shading Method to find 

the failing module in a string of N (quantity) modules, you can use the History Tab to show and 

compare the N measurement results. The column with the values that stand out compared to 

the other columns corresponds with the shaded the bad module. 

The current contents of the History table are saved in your Project file, so the most recent 

contents will still be there when you close and re-open the Project. However, the contents are 

not saved to the System Tree like your I-V curves, and when you recall an I-V curve from the 

System Tree, the History table is not updated to match that recalled measurement. Also, the 

History table contents are not exported when you export your I-V curve data.

Insulation Test Tab

Use the Insulation Test tab to record insulation resistance measurement results obtained from 

a separate instrument such as the Fluke 1587FC Insulation Resistance Tester. The Insulation 

Test Tab is hidden by default. To show this tab, use the control in the View menu. See Table 12. 

 

Table 12. Insulation Test Tab Description

 Item Description

A
Add Measurement - Adds a new line to the table, lists the current date and time, and 

the line is assigned an ID number. Enter the insulation resistance value.

B Delete Measurement - Deletes the currently-selected measurement from the list.

A B C

J
I

GH F E D
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The Exported I-V Data File

This section describes the organization of the csv file created when you export measurements 

from the Software. 

I-V Curve Tracer users typically analyze their measurement results with the Data Analysis 

Tool (DAT) Excel macro which automates the analysis and reporting process. Download a free 

copy of the DAT by visiting www.fluke.com. To use the DAT, first export your Project data 

from the I-V Curve Tracer by selecting File>Export Traces for Entire System... See File 

Menu and then import that data into the DAT (see the instructions in the DAT software for how 

to import). 

When you export Project data, the Software creates a folder tree on your hard drive that has 

the same hierarchy as your Array Navigator system tree. The I-V trace data exports to this 

folder structure in csv files. If you measured strings of PV modules but did not save 

measurements of the individual modules in the strings, the lower-level directories in your 

folder structure contain the string I-V trace csv files. 

When you use the Data Analysis Tool, import some or all of this data into the DAT for 

automated analysis and reporting. Browse to the necessary level of the folder hierarchy.

 Item Description

C
Limit Resistance - Enter the minimum acceptable value of insulation resistance. Any 

measured values that are below this limit are highlighted in red in the table. 

D Description - Optional description of the measurement or circuit.

E
Voltage - The voltage at which the insulation resistance was measured. Click this 

field to enter the value.

F
Resistance - The measured value of insulation resistance in megohms. Click this field 

to enter the value.

G
ID - Automatically assigned identification number. The ID number increments by one 

count each time a measurement is added.

H
Array Location - Accesses the System Tree to select the location at which the 

measurement was made. 

I Date/Time - Shows the date and time each measurement was added to the table.

J
Selection box - Selects the measurement to delete. Click Delete Measurement to 

delete selected measurement.

Table 12. Insulation Test Tab Description (cont.)

https://www.fluke.com
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To view the individual I-V trace data files, use a program that can read csv files, such as 

Microsoft Exceltm. This section describes the organization and contents of the csv file. 

Table 13 shows the header information section of the csv file.

Figure 12 shows the values of some of the measured and predicted points on the I-V curve. 

The abbreviations represent maximum power (Pmax), maximum power voltage (Vmpp or Vmp) 

and maximum power current (Impp or Imp), open circuit voltage (Voc), and short circuit current 

(Isc). 

Table 13. CSV Header Information

Menu Item Description

Report Date and Time
When your measurement was made, as recorded from the clock 

on the PC. 

Software Build
The version of I-V Curve Tracer software that took this 

measurement. 

Project File
The name of your Project File at the time this measurement was 

taken. 

Array Location 

The location in the System Tree at which the measurement was 

saved. Normally, this maps directly into the hierarchy of the 

actual array. 

PVA Measurement Unit 

MAC Address
The unique network address of the I-V Curve Tracer.

SolSensor MAC Address The unique network address of SolSensor.
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In the Software, the value of Pmax is obtained by fitting a third-order polynomial curve to the 

P-V (Power vs. Voltage) curve, and then calculating Vmp (max power voltage) from the peak 

of the fitted curve. This value of Vmp is then used to interpolate Imp (max power current) from 

the I-V curve. This method reduces the amount of uncertainty contributed by electrical 

noise in the current and voltage measurements. The Data Analysis Tool (DAT) re-calculates 

Pmax for the charts and reports data. It optionally fits a fourth-order polynomial, which can 

result in a slight difference in Vmp, Imp, and Pmax between the Software and the DAT and is 

generally a better fit.

Figure 12. Measurement vs. Model Selection of Exported CSV File
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Table 14 shows the SolSensor Measurements section of the exported csv file, and the table 

describes the contents. All of the values were recorded at the time the I-V measurement was 

made. 

Table 14. SolSensor Measurements Section of Exported CSV File

Menu Item Description

Irradiance

Value of irradiance measured by SolSensor integrated Silicon 

photodiode sensor. This is the Preliminary Irradiance and is 

calibrated and temperature corrected, but is different from the 

Effective Irradiance. Effective Irradiance is used in the PV model and 

is generally a better irradiance match for the modules selected than 

the preliminary irradiance. 

Temperature 

Thermocouple 1

The temperature indication from the thermocouple plugged into 

SolSensor TC1 socket. 

Temperature 

Thermocouple 2

The temperature indication from the thermocouple plugged into 

SolSensor TC2 socket.

Pitch The angle of SolSensor about its short axis..

Roll The angle of rotation of SolSensor about its long axis.

Tilt SolSensor tilt, calculated from the pitch and roll.
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Table 15 shows the Model Details section of the exported csv file.

Table 15. Model Details Section of CSV File

Item Description 

Irradiance used in model 
The value of effective irradiance used in the predictive 

model. 

Cell temperature used in 

model 

The value of PV cell temperature used in the predictive 

model. 

Tilt used in model The value of array tilt used in the predictive model. 

Array azimuth 
The compass direction the array faces. 0=N, 90=E, 180=S, 

270=W. 

User Series R 

The resistance of the conductors between the point of 

measurement and the PV source (typically, the home run 

conductors), calculated from the wiring details entered by 

the user when the Project was created. 

Performance Factor 
The ratio of measured to predicted maximum power, 

expressed in %.

Latitude and Longitude The location on Earth where the measurement was made. 
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Figure 13 shows the voltage, current, and power data saved from the measurement. The 

number of entries depends on the I-V curve resolution selected by the user for this particular 

measurement (default 100 points, user settable to 500 points).

The saved data array in Figure 13 does not include the final values of Isc or Voc (final values are 

as shown in Figure 10). The PV model projects the first current point onto the vertical (current) 

axis of the I-V graph to calculate Isc. The uncertainty introduced by this step is minimal. The 

final value of Voc is measured an instant before the start of the I-V curve sweep with a separate, 

internal high-impedance voltmeter. This assures that the PV source circuit is truly unloaded 

when you measure Voc. 

Figure 13. Voltage, Current, and Power Data from I-V Measurements

Item Description 

Time zone The time zone in which the measurement was made. 

Model Mfr Manufacturer of the PV module.

Module Model Model number of the PV module.

# of Modules in String 
Number of modules connected in series in the measured 

string. 

# of Strings in Parallel Number of strings measured in parallel. 

Wire AWG 
Wire gauge of the conductors between the point of 

measurement and the PV source. 

Wire Length 
Length (one-way, in ft) of the conductors between the point 

of measurement and the PV source.

Table 15. Model Details Section of CSV File (cont.)
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Basis of PV Performance Predictions

The Software predicts the electrical output of the PV source under test (module or string) 

based on the module parameters, the irradiance and temperature, the sun's angle of incidence 

on the array, and other factors. The subsequent discussion outlines the process by which 

SolSensor is calibrated and measures irradiance, and the process by which the Software 

predicts the three expected points on the I-V curves. 

SolSensor Irradiance Calibration

The SolSensor factory calibration process involves this sequence of steps:

1. Calibration of the electronic tilt sensor. 

2. Calibration of the angular response of the irradiance sensor.

3. Calibration of irradiance measurement at air mass 1.5 and normal incidence, relative to a 

solar simulator.

4. The unique calibration coefficients are stored in SolSensor and are transmitted to the 

Software on demand.

Irradiance Measurement

SolSensor measurement of irradiance involves these steps:

1. Clamp SolSensor to the module frame to orient it in the plane of the array. 

2. The position of the sun relative to the orientation of the irradiance sensor is calculated 

based on the array azimuth and tilt, the time and date, and the site latitude and longitude. 

3. The irradiance value is temperature corrected based on the indication of a temperature 

sensor attached to the irradiance sensor and based on the angle of incidence of the 

irradiance. 

4. One of four spectral corrections is applied, according to the PV module technology (poly-

Si, c-Si, HIT-Si, or CdTe) of the array. The corrections are derived from module/sensor 

spectral overlap calculated by SMARTS atmosphere model as a function of air mass and 

elevation. 

This process yields the effective irradiance incident on the cells in the PV module. Effective 

irradiance is the portion of the total irradiance that the module can convert into electricity.
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Prediction of PV Performance

The Software compares the measured I-V curve to the predictions of the built-in PV 

performance model. The Performance Factor is calculated from this comparison. 

The prediction process involves these steps:

1. Create a Project and input all required parameters that include selection of the PV module 

from the built-in equipment database.

2. The model predicts Isc, Imp, Vmp, and Voc for the current values of irradiance and 

temperature. 

3. Under low-light conditions, the prediction is adjusted based on 200W/m2 performance data 

in the database.

4. The Performance Factor - the ratio of measured Pmax to predicted Pmax - is calculated 

and expressed in percent. The Performance Factor is the most important metric of the 

performance of the PV module or string.

Translation of Measured Values to STC

Measured values of Isc, Imp, Vmp, and Voc are translated to STC with the irradiance and 

temperature dependence factors stored in the model database, and the translation equations 

from, Translation of I-V Data to Standard Test Conditions.

Measurement of Isc

The I-V Curve Tracer uses a pre-charge capacitor to start the I-V sweep at a slightly negative 

voltage, to overcome small voltage drops and transients inherent in the measurement loop 

and ensure that the true Isc value is measured. Under certain circumstances of PV source 

under test, this pre-charge may not be sufficient to start the I-V trace at or below 0 V. In such 

cases, a small gap occurs between 0 V and the first measured I-V pair, and the Software 

constructs a horizontal line from the first measured I-V point to the vertical axis to estimate Isc. 

The intersection of the horizontal line with the vertical axis is reported as Isc. In most cases, this 

is an extremely close approximation.

The high-efficiency modules store a large amount of electrical charge. At the start of the 

sweep, this reservoir of charge quickly flows into the pre-charge capacitor and steps its 

voltage such that the first I-V point is in positive voltage territory. In some instances, especially 

with 500 points, the first few I-V points may be slightly elevated due to the residual discharge 

of the PV module capacitance. In such cases, you may see a slight, flat plateau in the I-V curve 

just above 0 V. This deviation from actual Isc is typically extremely small. This typically does not 

occur with the PVA-1500HE2 because it handles strings of high efficiency modules and their 

large in-rush current. 
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Calibration Verification

The I-V Curve Tracer includes a dialog called Calibration Verification. This is typically used by 

laboratories equipped to verify calibrations. To access, click Utility>Calibration Verification. 

This dialog shows continuous measurements of voltage, irradiance, thermocouple 1, 

thermocouple 2, and tilt. This dialog can be used to verify the calibration and accuracy of the 

PVA sensors. The irradiance reading is the Preliminary Irradiance that includes calibration 

factors and temperature correction but does not include further modeling (for example, for 

effective Irradiance). This reading is suitable to compare the SolSensor reading to a reference 

cell outdoors under stable irradiance conditions or with a solar simulator. Verify current 

calibration and accuracy with the setup described in the app note PV Analyzer Calibration 

Application Note (see link in the dialog) and push the Measure I-V Unit Current button. 

Adjustment to the calibrations must be done by Fluke.

Software Updates

The Fluke website posts software and manual updates. Periodically check the website at 

www.fluke.com to download the latest of both. Compare the Software and manual version 

numbers with the versions that you have. To update the software or manuals, download the 

latest versions and run the free Software installer. See Help Menu to locate your current 

Software version.

I-V Curve Tracer and SolSensor Firmware Updates

The firmware of the I-V Curve Tracer and SolSensor can be updated in the field. 

When the PC is connected to the Internet and you launch the Software, the Software 

downloads the most current firmware versions for the I-V Curve Tracer and SolSensor. Then 

the next time your PC is Wi-Fi connected to the two instruments, the PC software reads their 

current firmware versions and recommends that you run the update if necessary. Once 

downloaded, the updates take approximately 2 minutes per instrument and do not require an 

Internet connection. If your SolSensor is not with you, or is not turned on, or is not within Wi-Fi 

range when you run the update process, only the I-V Curve Tracer firmware is updated, and 

you can update SolSensor firmware the next time it is wirelessly connected to the I-V Curve 

Tracer.   

To manually check the I-V Curve Tracer and SolSensor firmware versions:

1. Launch the Software.

2. Wirelessly connect to the instruments.

3. Select Help.

4. Select Connected Measurement Devices. 

The current versions of firmware are shown. Periodically launch your Software while 

connected to the Internet to see notices of any Software updates. From there, download 

recent firmware updates and have them ready to update your instruments in the field.

https://www.fluke.com
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Make Measurements

This section describes the steps to take measurements in the field. See the printed Safety 

Information that ships with the I-V Curve Tracer.

Before You Take Field Measurements

Charge the Equipment

Before you bring your instruments to the field, charge both the I-V Curve Tracer and SolSensor 

overnight. 

 If the Software is running and the I-V Curve Tracer and SolSensor are connected, a 

lightning bolt charge icon appear in the upper right over I-V or SS as they charge. 

 If the internal temperature of the I-V Curve Tracer is too hot (for example, due to many high 

voltage I-V sweeps and/or hot environmental conditions), the battery does not charge and 

the I-V charging icon has a red X over it. SolSensor may also be in an over-temperature 

state, although it is less common than for the I-V Curve Tracer. 

The equipment typically runs for 7 hours to 8 hours on a charge. Turn the equipment off when 

not in use.

Make Sure to Run the Latest Software

Double click the PVA icon on your PC to run the Software. See Software Updates.

Create a Project in the Software

Create a Project ideally where you have an Internet connection and engineering drawings of 

the PV installation. For large plants this is often done at the office before entry into the field. 

Make sure that the created Array Tree accurately represents the architecture of the PV 

system. See New Project.     

Assure Adequate Irradiance for Your Measurements

Performance measurements are best performed in the range of 700 watts to 1000 watts per 

square meter. If possible, choose a day when the skies are clear. If there are clouds, try to 

trigger measurements at the moments when there are no clouds near the sun. Also try to take 

measurements in a 6-hour window centered on solar noon. 

If you measure a horizontal single-axis tracker, you can set up the Project to allow the tracker 

to run as you take measurements. This provides a more consistently-high irradiance in the day.
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Measurements in the Field

Measure the Open Circuit Voltage (Voc)

If the open circuit voltage (Voc) of the PV source circuit exceeds the maximum dc input voltage 

specification of the I-V Curve Tracer, your Product may be damaged. Before you start 

measurements at a new PV field, measure a string with a properly-rated digital multimeter 

(DMM) to make sure Voc is within the dc voltage range of the I-V Curve Tracer. This step 

prevents damage to the Product and saves time.

Connect the I-V Curve Tracer Test Leads

Slide open the banana jack dust cover on the I-V Curve Tracer and connect the banana jacks to 

the I-V Curve Tracer (red to red, black to black). There are two types of test leads, banana to 

alligator clip and banana to MC-4. 

Connect the alligator clips to the ends of the test leads. Make sure to use only the 1500 V rated 

test leads and alligator (dolphin) clips supplied by Fluke with the I-V Curve Tracer.

Launch the Software

Double click the desktop PVA icon to start the Software. 

Load Your Project

Select your Project from the File menu in the Software. The Project must be created 

specifically for the PV installation you are about to measure. 

Measure Individual Strings versus Parallel Strings

Typically, you should measure each string individually to get the best insight and resolution in 

the performance. If you measure multiple strings in parallel, make sure that the maximum PV 

current you plan to measure is less than the specified maximum current of the I-V Curve 

Tracer. To estimate the maximum current the paralleled strings will produce, measure a single 

string in full sun, and multiply the measured short circuit current (Isc) by the number of strings 

you plan to measure in parallel. Be aware that the maximum total current increases when the 

sun is more directly in front of the array, and that in the span of a few seconds, cloud edge 

effects can increase total current more than 25 % above normal clear-sky conditions.    

Measure High-efficiency Modules

High-efficiency modules have high capacitance that cause a large in-rush current when I-V 

curves are measured. The PVA-1500HE2 handles this in-rush current for strings of high 

efficiency modules up to 30 A. 
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The PVA-1500T2 handles this in-rush current from PV circuits up to 30 A short circuit current 

when the module efficiency is <19% or up to 10 A short-circuit current when the module 

efficiency is ≥19%. The in-rush current is increased by higher efficiency, higher current strings, 

higher voltage strings, higher bifaciality, and higher irradiance. For example, a 1350 V string of 

bifacial 21% efficiency modules with Isc of 18 A at irradiance around 1000W/m2 will likely 

cause the over-current warning in a PVA-1500T2. Lower string voltages can allow currents 

higher than 10 A, even with high efficiency modules, so breaking-up strings to reduce voltage 

and adjusting tracker orientation for lower irradiance can be an I-V measurement solution in 

some cases. For more information on high efficiency modules, see the Solmetric app note I-V 

Curve Tracing of High Efficiency PV modules. 

Connect the Test Leads to the PV Equipment

Observe the correct polarities (red test lead to dc positive, black test lead to dc negative).

If you measure circuits at a combiner box, after you open the dc disconnect switch to 

disconnect from the inverter and lift all the fuses (if the combiner has one fuse per string) or lift 

all of the positive-side fuses (if the combiner has two fuses per string), connect the PV test 

lead alligator clips to the positive and negative buss bars. This allows you to insert one string 

fuse at a time to select the PV circuit to test. 

Select the First PV Circuit to be Measured

If you use the string fuses to select PV circuits, insert the first fuse.

Make the First Measurement

Push Measure Now. The measured trace typically appear in 1 second to 11 seconds. See 

Figure 14.
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Figure 14. Results of an I-V Curve Measurement

After the measured I-V curve trace appears, the I-V graph slides to the left and the PV system 

Array Tree appears at its right. 

Navigate to the location in the tree that matches where you took your measurement. Highlight 

that branch of the tree and click Assign and Save. If you do not want to save the trace but only 

want the software to compare the measured trace with the predictions of the PV model, 

instead push Assign Only. 

When you Assign and Save, the software performs checks (Alerts) to automatically detect 

problems. For more information, see Alerts.

The Array Tree closes and the I-V curve expands to its full width. 

Inspect the curve for abnormal shapes and notice the values of the Fill Factor and the 

Performance Factor below the I-V curve graph. Fill Factor gets smaller if the I-V curve is poorly 

shaped. Expect Performance Factors to be mostly in the 90 % to100 % range for a new, clean 

array. If the values are much higher or lower than that, check that the irradiance sensor is 

mounted in the plane of the array, that the PC date, time, and time zone are correct, that the PV 

module parameters are correct, and that the array azimuth and array type are correctly set. 

Inspect the sensor values that were saved with the measurement. They are directly below the 

I-V curve graph.



PVA-1500HE2/PVA-1500T2/SolSensor-300V3

Users Manual

56

Select the Next PV Circuit and Make Another Measurement

If working within a combiner box, lift the previous fuse and insert the next one. Repeat the 

above steps to make and save your measurement. 

Be aware that when your measurements are finished and the data is exported from the 

Software, the Software exports only the last measurement saved to each branch of the Array 

Tree. If you take extra measurements while troubleshooting a string that under performs, be 

sure to take one final measurement of the repaired string, for export. 

View Consistency of Data

Before you move to the next combiner box or inverter, click the History tab and scroll left-to 

right to see the numerical results of the measurements at this combiner box. The most recent 

measurement appears in the left column. Check for any outliers.

For example, the Voc values should be closely grouped to indicate that the strings all have the 

right number of modules. 

The Isc values should also be closely grouped if it is a clear day and the irradiance is nearly 

constant. 

A low Fill Factor means that the shape of the I-V curve is degraded. This can be caused by 

shading, soiling, or debris or equipment on the modules under test. See Interpret Measured I-

V Curves.

It helps to clear the History table before you move to the next combiner box. 
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Alerts

After you make a measurement and select Assign and Save, the Software does automatic 

checks to detect potential problems with the measurement setup or with the circuit under test. 

These are called Alerts. Table 16 lists the Alert types. Some Alerts can be disabled from 

appearing again within the session. Disabled alerts become re-enabled when the software is 

re-started. Alerts only appear when a project with a model is loaded.

Data Backup

The Software has an automatic backup feature. By default, the Software backs up the Project 

every 20 times that you save an IV trace. To enable or disable this functionality, change how 

often it backs up, or change the backup folder location, select File>Project Backup Settings� 

To manually create a backup, click Create Backup Now. 

Table 16. Alert Messages

Alert Description

Large deviation 

in Effective vs. 

Preliminary 

Irradiance 

If the modeled effective irradiance deviates from the preliminary 

irradiance by more than 25 %, the Software shows an Alert that indicates 

the irradiance is deviating. This happens if the longitude, latitude, time/

date, or azimuth is incorrect in the Site Info or if SolSensor is not mounted 

in the plane-of-array. 

Smart Temp 

Detected 

Problem

If the SmartTemp algorithm detects a deviation of >8 oC between the 

blended temperature calculation vs. the thermocouples, the Software shows 

an Alert to indicate the deviation.

Large Deviation 

between 

Thermocouples 

If the deviation between thermocouple indication is >5 oC, the Software 

shows an Alert to indicate the deviation. 

No SolSensor 

Readings 

If SolSensor does not receive data or is not connected to the Software, 

the Software shows an Alert to indicate the condition. Determine whether 

to accept the trace without SolSensor data or discard the trace.

User-Set 

Threshold 

Exceeded

If one of the user-defined alert thresholds is exceeded, the Software 

shows an Alert to indicate the deviation (for example Isc alert). Select 

Configure Measurement Alert Thresholds in the Utility menu to 

configure the user-defined Alerts. 
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Measure Irradiance, Temperature, and Tilt

Thorough evaluation of array performance by any measurement method involves comparing 

measured data to a reference. That reference may come, for example, from a simple STC 

maximum power value or from a detailed PV performance model. In any case, you must know 

the irradiance in the plane of the array and the array temperature to properly evaluate array 

performance against your reference. 

You must consider a number of factors to assure good measurement results. This section 

provides the background necessary to make informed choices for your specific application. 

Measuring irradiance presents a number of requirements and challenges: 

 Irradiance must be measured in the plane of the array (POA)

 Irradiance may not be uniform across the surface of the array due to shading and albedo 

effects, as well as local cloud effects

 Irradiance can vary rapidly

 Irradiance sensors may have different spectral responses than the PV modules themselves

 The solar spectrum shifts significantly early and late in the day

 The shape of the PV module I-V curve changes at low irradiance levels

The temperature parameter of interest to the PV model is the average temperature of the PV 

cells in the string or module under test. To determine the average cell temperature poses a 

number of challenges: 

 The PV cell is embedded in other materials, so you cannot measure the cell temperature by 

direct contact. 

 The materials in which the PV cell is embedded have poor thermal conductivity, so there 

can be substantial temperature drop between the cells and the module front side or back 

side. 

 Temperature offset between the PV cell and module backsheet depends on racking 

configuration and ventilation as well as current irradiance.

 Temperature is not uniform across a PV module or array due to variations in racking 

configuration and ventilation.

 Temperature at a given location can vary with time, even at constant irradiance, due to 

convection currents and wind.

 An air gap between a backside temperature sensor and the actual backside surface results 

in significant temperature error.

 Massive temperature sensors, particularly bulky RTD devices, do not track rapid changes 

in module temperature.

 Surface and material issues limit the accuracy of infrared temperature measurements. 
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The Software provides multiple methods to measure irradiance, temperature, and tilt, as 

shown in Table 17.

Measure Irradiance with SolSensor

SolSensor Irradiance Sensor

Fluke recommends, in most cases, to use the SolSensor as the source of the irradiance 

measurement. The SolSensor irradiance sensing element is a silicon photodiode with 

temperature correction. Its spectral response is corrected to match silicon solar cells and its 

angular response is corrected to provide enhanced accuracy over a broader part of the day. 

Preliminary vs. Effective Irradiance

SolSensor produces a preliminary irradiance that is calibrated and temperature corrected (for 

the temperature of the photodiode). The preliminary irradiance is further corrected according 

to the PV model parameters for the selected PV module to calculate the effective irradiance 

which is the irradiance seen by the actual PV cells. If a Project and model have not yet been 

created, SolSensor values do not receive this further correction, and preliminary irradiance 

values are shown. In this situation, the irradiance value displayed in the live SolSensor readings 

section on the right of the screen is rounded to the nearest 10W/m2 and printed in italics. 

Once the Project and model are created, the effective irradiance shows in normal font with a 

resolution of 1W/m2. Expect to see slight differences between preliminary and effective 

irradiance based on the corrections. To see the measured (preliminary) irradiance with 1W/m2 

resolution go to the Calibration Verification dialog under the Utility menu. See Calibration 

Verification.

SolSensor Precautions

Protect the Irradiance Sensor Element

When not in use, keep the irradiance sensor (white acrylic disc) covered by the supplied black 

rubber cover. Remove the cover after you mount SolSensor in the plane of the array, and 

replace the cover before you move SolSensor to another location. 

Table 17. Sensor Choices

Irradiance Temperature Tilt

SolSensor SmartTemp SolSensor

From I-V curve From I-V curve Manual entry

Manual entry Thermocouple 1 -

- Thermocouple 2 -

- Average of TC1 and TC2 -

- Manual entry -

Use any combination of methods depending on the requirements of your application.
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W Caution

To avoid SolSensor damage, keep the cover on the irradiance sensor when not in 

use. The sensor is easily damaged by impact or abrasion, and accuracy is also 

compromised by soiling. The white acrylic eye of the irradiance sensor is a 

precision optical element which must be kept in new in condition to assure 

accurate measurements. 

Diffuse Light

As sky conditions become hazy, a greater fraction of sunlight is scattered. This scattered or 

diffuse portion of the irradiance on the array from all directions and angles. It can be 

challenging for some irradiance sensors, depending on their construction, to accurately 

measure irradiance in the presence of significant diffuse irradiance. For example, some hand-

held irradiance sensors have poor cosine response and their accuracy is specified only for 

direct normal irradiance, that is, clear days and pointed directly at the sun. A reference cell 

similar in technology to the cells of the modules under test reduces this error, but does not 

eliminate it. The SolSensor irradiance sensor is corrected for angular effects and results in 

better performance under diffuse light conditions.

Determine Irradiance from the Measured I-V Curve

Fluke recommends, in most cases, to use the SolSensor as the source of the irradiance 

measurement. However, there are certain times when it is useful to use the From I-V setting. 

When you select the From I-V option, the Software calculates irradiance from the measured I-

V curve. This option has benefits and limitations. 

From I-V option provides these benefits:

 There is no time delay between measurement of the I-V curve and determination of 

irradiance. This is helpful when irradiance changes rapidly (ramping) due to moving clouds, 

a condition under which any time delay between I-V and irradiance measurements 

translates into irradiance error. 

 You can measure cell technologies that have a poor spectral match to the SolSensor 

silicon irradiance sensor. 

 Since the predicted Isc value is forced to agree with the measured Isc value, it is easy to 

notice any deviations between the shapes of the measured and predicted I-V curves. 
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From I-V irradiance option also has these limitations:

 Uniform soiling is interpreted as reduced irradiance and thus does not cause a deviation 

between the measured and predicted I-V curves. Inspect the array before you measure, 

and clean it if needed to mitigate this risk.

 Similarly, uniform degradation of module Isc is also interpreted as reduced irradiance, and 

thus is not detected. 

 The From I-V irradiance value is used by the predictive PV model to calculate the expected 

value of Isc. Using a measured value to calculate the expected value is circular, and forces 

the expected value of Isc to agree with the measured value.

Enter the Irradiance Manually

When you select this option, manually enter an irradiance value obtained by another method 

such as a hand-held sensor or an array-mounted reference cell. This option has these 

limitations:

 Accurately orienting hand-held irradiance sensors in the plane of the array is difficult.

 A greater and more variable time delay between the I-V curve and irradiance 

measurements translates into irradiance error under conditions of rapidly changing 

irradiance. 

 Hand-held irradiance sensors may have poor accuracy, especially in their cosine response. 

This introduces significant irradiance errors when the sun is off axis of the array and under 

diffuse light conditions. 

Measure the Backside Temperature of a PV Module with a 

Thermocouple

Measurement of the module backside temperature is one of the traditional methods used by 

I-V curve tracers. It has several benefits and limitations. Note that some of the necessary 

items are covered in Set Up and Use the I-V Curve Tracer and SolSensor.

The Backside Thermocouple method provides these benefits:

 It is a direct method with no dependence on a PV model. 

 It enables you to choose the location for temperature measurement. It is best to choose an 

average temperature location and avoid locations that are much hotter or much closer to 

the cooler edges of the array. 
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The Backside Thermocouple method has these limitations:

 The predictive PV model wants to know the cell temperature, but the thermocouple 

measures the slightly cooler backside temperature. The Software partially compensates 

for this by modeling the temperature drop from cell to backside (adding up to 3 °C to the 

measured backside temperature). The amount of compensation varies in proportion to 

irradiance, since at high irradiance the difference between cell and backside temperature is 

higher.

 Backside temperature varies substantially across a PV module, string, or array. This 

variation is caused by patterns of convective cooling that depend on degree of ventilation, 

relative location in the array, and exposure to wind. For this reason, your temperature 

measurements can be biased higher or lower than actual. 

Select a Thermocouple Wire Gauge

Fluke recommends the use of the thermocouples supplied with the SolSensor, but if you use a 

different thermocouple, choose a relatively fine thermocouple wire gauge, ideally #24 or #30. 

Some users prefer #24 for extra ruggedness and handle-ability. 

There are various reasons to use one of these finer wire gauges:

 For accurate temperature measurements, the tip of the thermocouple must be kept in 

good physical contact with the backside surface. An air gap between the thermocouple 

and backside surface translates into a lower temperature reading. Typically, tape is used to 

hold the thermocouple in place. Stiff thermocouple wire is not compliant enough to allow 

the tape to do its job. 

 Because heavier-gauge thermocouple wires are more massive, the thermocouple cannot 

respond as quickly to temperature variations caused by wind or changes in irradiance. 

Under changing conditions, a measurement delay translates to a measurement error. 

 The thermocouple wires themselves drain a small amount of heat away from the tip of the 

thermocouple. This heat drain causes a slight temperature drop in the module backside 

material which has poor thermal conductivity. 

Select a Thermocouple Tip

A variety of tip styles are available. The simple beaded tip is a good choice because it is rugged 

and reliable and has relatively low mass, that allows it to quickly track variations in temperature. 

Lower-mass tips with integral adhesive strips can also be used, but experience shows that 

these devices are easily damaged. 
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Measure PV Module Temperature with an Infrared Thermometer

Some measurement solutions rely on infrared measurements of module temperature. This 

approach has serious limitations. 

Since the IR thermometer determines temperature by sensing radiant energy emitted by the 

object being measured, the accuracy of the temperature measurement depends on how 

closely the emissivity control setting of the instrument matches the actual emissivity of the 

object. The emissivity of a material is a measure of its relative ability to emit energy through 

radiation. It is the ratio of energy radiated by a particular material to energy radiated by a black 

body at the same temperature. A true black body would have an ε = 1 while any real object 

would have ε <1. In general, the duller and blacker a material is, the closer its emissivity is to 1. 

The more reflective a material is, the lower its emissivity. Highly polished silver has an 

emissivity of about 0.02. 

Some IR thermometers allow continuous adjustment for emissivity. Some models provide only 

a high/medium/low setting, which limits your accuracy. Some use a factory preset emissivity 

and are not user-adjustable. 

PV module backsides do not all have the same emissivity, so you must either adjust the 

emissivity control of the instrument to match the backside surface or change the emissivity of 

the backside surface to match the instrument. Flat black electrical tape is commonly used to 

achieve high emissivity. With this technique, you can set the emissivity control at 1 and have 

reasonable accuracy. 

If you do not use tape, you can calibrate your instrument against another measurement 

method, usually a thermocouple taped to the back of the same PV cell (see guidelines 

discussed earlier). Adjust the emissivity until the temperature indications are the same. Keep in 

mind that this emissivity setting is calibrated only for this particular type of module backside.

With infrared techniques, do not measure module temperature from the front side of the 

module. Glass reflects the heat of other objects, especially the sun. Also, the glass may not be 

completely transparent to the wavelength of the IR instrument. As a result, the temperature 

indication will be some function of both the glass temperature and the PV cell temperature. 

Determine Cell Temperature from the Measured I-V Curve

When you select the From I-V option, the Software calculates the equivalent cell temperature 

from the measured I-V curve. This option has several benefits and several limitations, all due to 

the fact that since temperature is calculated mainly from the measured Voc and the resulting 

temperature value is an input to the PV model, the model dot that represents Voc is forced to 

agree with the measured value of Voc. 
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From I-V temperature option provides these benefits:

 The temperature value that results represents the average cell temperature, which is what 

the PV model needs. The method properly accounts for temperature variation across the 

module or string under test. 

 There is no time delay between measurement of the I-V curve and determination of 

temperature. This is helpful when module temperature changes rapidly, a condition under 

which a time delay translates into a temperature error. Rapid temperature changes can 

result from variable cloudiness and also from gusty wind. 

 Since the predicted Voc value (the right-hand red dot superimposed on the displayed I-V 

curve) is forced to agree with the measured Voc value, it is easier to notice any deviations 

between the shapes of the measured and predicted I-V curves. 

From I-V temperature option also has these limitations:

 The model by which temperature is determined from Voc is valid only at relatively high 

irradiance. At low irradiance, there is substantial error in the derivation of temperature. 

 If the PV source under test has one or more shorted or conducting bypass diodes, the 

Software calculates a lower-than-actual cell temperature. You can mitigate this risk by 

comparing Voc values between strings or modules under test. Values should be fairly 

consistent. If a single string shows a deviation of more than about 10 V to12 V, a bypass 

diode may be turned on or shorted.

 The From I-V cell temperature value is used by the predictive PV model to calculate the 

expected value of Voc. Using a measured value to calculate the expected value is circular, 

and forces the expected value of Voc to agree with the measured value. 

Measure PV Module Backside Temperature with a Thermocouple

Fluke recommends the use of the SmartTemp setting and one or two thermocouples on the 

backside of a module. The SmartTemp method uses a blend of the From I-V and backside 

thermocouple methods, that takes best advantage of each while it avoids the biggest 

limitations of each. The blend changes as a function of irradiance:

 At irradiance values <400W/m2, temperature is obtained from the backside thermocouple. 

 At irradiance values >800W/m2, temperature is calculated with the From I-V method. 

 At irradiance values between 400W/m2and 800W/m2, the Software progressively shifts 

between the thermocouple and From I-V methods. 
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This strategy employs the From I-V method at high irradiance values where it is most accurate, 

and relies on the backside thermocouple at low irradiance values where there is a relatively 

small temperature offset between the module backside and cell.

If the Software detects a temperature difference of more than 5 °C between the thermocouple 

and From I-V methods, the Software switches to use just the thermocouple. This reduces the 

likelihood of temperature errors caused by a missing module or shorted bypass diode. 

Interpret Measured I-V Curves

A PV module, string, or array has a characteristic curve of current versus voltage: the I-V curve. 

The I-V curve represents the family of current and voltage pairs at which the PV circuit can 

operate at the corresponding irradiance and temperature. The I-V Curve Tracer mathematical 

models predict the shape for this curve for thousands of different PV modules and 

configurations. Occasionally, the shape of the measured I-V curve deviates substantially from 

the shape predicted by the model. These deviations contain information about the 

performance of the PV System and provide important clues to troubleshoot performance 

issues. This section describes the most common patterns of deviation and identifies the most 

likely causes for these deviations.

Inputs to the PV Model

The modeling features of the I-V Curve Tracer predict the shape of the I-V curve for 

comparison with measured results. For the prediction to be valid, the inputs to the model must 

be valid. The model inputs are:

 PV model parameters stored in the Software

 Number of PV modules in series

 Number of PV modules or strings being measured in parallel

 Length and gauge of wire between the PV modules and the I-V Curve Tracer

 Irradiance

 PV cell temperature 

 Array azimuth and tilt

 Latitude and longitude

 Date, time, time zone, and daylight savings information
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I-V Curve Terminology

These abbreviations are used in this discussion:

Isc Short circuit current

Imp Max power current

Vmp Max power voltage

Voc Open circuit voltage

PF Performance Factor (PF, %) = 100 * (Measured Pmax/Predicted Pmax)

FF Fill Factor = Imp * Vmp / (Isc * Voc) 

Performance Factor

The Performance Factor is the most important figure of merit for PV array performance. 

Performance Factor is the measured maximum power value divided by the predicted 

(modeled) maximum power value. Its range is 0 % to 100 %.

The predicted maximum power value is determined by the PV model, which takes into account 

the current values of irradiance and temperature. This means that Performance Factor is 

meaningful over a range of irradiance and temperature. Like most array performance 

measurements, the comparison is more accurate if the irradiance levels are high. Performance 

measurements taken at less than 400W/m2 irradiance are not good predictors of how the 

string performs at high irradiance. 

If a PV string or module operates correctly and is not shaded, soiled, or age-degraded, and is 

measured at high irradiance, the measured Performance Factor will typically be in the range of 

90 % to100 %. If the irradiance is stable and the array temperature does not change rapidly, 

the measured I-V curves should be very consistent from string to string.

Fill Factor

The Fill Factor is a valuable measure of the squareness of the knee of the I-V curve. A more 

square knee indicates a greater ability to convert sunlight into electrical power. Fill factor is 

defined by three points on the I-V curve, as shown in Table 18. The Fill Factor range is 0 to 1.0, 

and the closer the Fill Factor is to 1.0, the closer the shape of the I-V curve approaches a 

perfect rectangle. Each PV technology has its own nominal range of fill factor values, and each 

module model number typically has a narrow nominal range.

Fill Factor does not vary much with irradiance so long as the irradiance is high, which means 

that a comparison of Fill Factor values is a good way to assess the consistency of I-V curve 

shapes in variable (but high) irradiance situations.
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Table 18. Definition of the Fill Factor

The Shape of a Normal I-V Curve

Table 19 shows a normal I-V curve (solid red line), as a start point for this discussion. The 

predicted I-V curve shape, determined by the PVA built-in PV model, is shown by the three red 

dots that represent Isc, (Imp, Vmp), and Voc. The I-V curve represents the entire family of points 

at which the PV circuit could be operated at the measured irradiance and temperature.

A normal I-V curve has a smooth shape with three distinct sections, see Table 18.

In a normal curve, the three sections are smooth and continuous. The shape and location of 

the knee depends on cell technology and manufacturer. 

The three PV model points are defined, from left to right in Table 18, as follows:

1. Isc - First point, at the predicted short circuit current Isc.

2. MPP - Second point, the predicted maximum power point Imp, Vmp.

3. Voc - Third point, at the predicted open circuit voltage Voc.

Number Description

A Slightly sloped horizontal leg of the curve.

B Knee in the curve between these two regions.

C Steeply sloped vertical leg of the curve.

(Imp, Vmp)

Imp x Vmp (green area)

Fill Factor = 

 Isc x Voc (blue area)

Voltage Voc

Isc

C
u

rr
e

n
t

A

B

C
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Interpret I-V Curves

PV module or string performance problems cause deviations between the measured and 

predicted I-V curves. There are six distinct types of deviation, listed below and in Table 19. A 

given PV source under test may show no deviation, one deviation, or a combination of two or 

more deviations. 

Each of the I-V curve deviations illustrated inTable 19 have multiple possible causes.

Note

Deviations from the predicted IV curve can be due to physical problems with the PV 

array under test or the result of measurement problems such as incorrect model 

values, instrument settings, or measurement connections. To minimize measurement 

problems, be sure to select the correct PV module from the on-board PV module list, 

double check the measurement connection, and ensure that irradiance measurements 

are taken in the plane of the array and are as simultaneous with the I-V sweep as 

possible. 

Small deviations between the measured and predicted I-V curves are common given the 

uncertainty associated with the irradiance and temperature measurements and the fact that 

PV modules, even of a given manufacturer and model number, are not all identical. Shading and 

soiling also have effects not taken into account in the PV model.

Potential causes of substantial deviations between measured and predicted I-V curves are 

discussed below.
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Table 19. Deviations in the Shape of the I-V Curve

Item Description

A Low Current

B Increased Slope in horizontal leg

C Steps

D Rounder knee

E Reduced Slope in vertical leg

F Low Voltage

A B
C

D

E

F

Isc

C
u

rr
e

n
t

Voc

(Imp, Vmp)

Normal Curve Voltage

Deviations



PVA-1500HE2/PVA-1500T2/SolSensor-300V3

Users Manual

70

Notches or Steps

Array Is Partially Shaded, or Non-uniform Soiling, or Debris is Present

Examples of this type of deviation are shown in Figure 15, Figure 16, and Figure 17.

Figure 15. The Effect of Partial Shading on a String I-V Curve
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Figure 16. Shading Impact of a Business Card Placed on a Single Cell in a String of 15 

180-watt Modules. 

Figure 17. Effect of Shading Entire Modules in Different Combinations

In single-string measurements, steps indicate current mismatch between the modules (or cell 

groups within modules) of the string under test. Although the figures shown above involve 

shading, mismatch can have other causes. The notches in the I-V curve are associated with 

conduction of bypass diodes that protect individual cell groups within modules that are not 

able to pass the full current of the stronger modules and cell groups. 
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Potential causes of steps in the I-V curve are summarized below, and then discussed in more 

detail:

 Array is partially shaded, or non-uniformly soiled, or debris is present.

 A mix of different PV module specs within the same string.

 PV cells are damaged.

 Bypass diode is short-circuited (only if measuring strings in parallel).

Partial shading of a PV cell reduces the current capacity of that cell, which, if there were no 

bypass diodes, would limit the current in the entire string to that level. For example, slightly 

shading one cell in a 72 cell, 3-bypass diode module causes that cell bypass diode to conduct 

enough current to maintain string current, and avoid damage to the weak cell. Without the 

bypass diode present, the weak cell becomes reverse biased, which could generate potentially 

damaging reverse breakdown voltage and hotspot failure. The impact of partial shading on the 

I-V curve is to create a notch. In a single PV string, the depth of the step from normal I-V curve 

height indicates the severity of the current mismatch, and the width of the step indicates how 

many cell groups are involved. 

PV Cells Are Damaged

There are cell-level failure modes that can reduce the ability of a cell to produce current. Also, 

cracks in the cell can electrically isolate sections of the cell. This has the same effect on the I-

V curve as shading of an equivalent area of a normal cell.

Low Current

This section lists potential causes for the measured Isc being higher or lower than predicted.

Uniform Soiling

The effect of uniform soiling is as if a window screen is pulled over the PV modules. The overall 

shape of the I-V curve is correct, but the current at each voltage is reduced. 

Dirt Dam

A constant-width band of dirt across an entire string can also reduce current. The most 

common example is a low-tilt array with modules in portrait orientation. Over time, a band of 

dirt collects at the lower edge of each module. When the band of dirt reaches the bottom row 

of cells, it begins to limit current. If the dirt bands are similar enough from module to module, 

the effect is like uniform soiling. 

Module Degradation

Degradation of PV module performance with time and environmental stress can reduce the 

current. Degradation is normally a slow process. Be sure to rule-out measurement technique-

related factors that can affect the height of the I-V curve, before you conclude that the 

modules have degraded.



Solmetric I-V Curve Tracer  Kit

Interpret Measured I-V Curves

73

Incorrect PV Module Is Selected for the PV Model

PV modules with similar PV model numbers may have different Isc specifications. Check that 

the module selected from the on-board module list matches the nameplate on the back of the 

PV modules. If the array is known to have a mix of PV modules of different types, this can 

contribute to changes in Isc. Mixed modules can also cause a mismatch effect, another class of 

deviation.

Number of PV Strings in Parallel Is Not Entered Correctly in the Model

The measured value of Isc scales directly with the number of strings in parallel. Check that the 

correct value is entered into the model, and that the measurement was saved to the correct 

branch of the array tree. 

Irradiance Changed Between Irradiance and I-V Measurements

The time delay between the irradiance measurement and the I-V measurement can translate 

into measurement error. The error is greatest when the sky conditions are not stable (for 

example, partially cloudy) and a manual irradiance sensor is in use. The process to orient the 

manual sensor, noting the value, and entering the value into the PVA software takes much 

more time than the automated process used by SolSensor.

Irradiance Sensor Is Not Oriented in the Plane of Array

The accuracy of the irradiance measurement is extremely sensitive to the orientation of the 

sensor. The I-V Curve Tracer model assumes that the irradiance sensor is oriented in the plane 

of the array. It is difficult to consistently position hand-held sensors in the plane of the array. 

To see how much error this can introduce, orient the sensor to match the plane of the array 

and note the irradiance value. Then remove the sensor and repeat several times within a 

minute, and examine the consistency of the recorded values. This experiment works only 

under stable irradiance conditions.

Albedo Effects (Reflection) 

The energy production of PV modules can be increased by reflection or scattering of light from 

nearby buildings, automobiles, and other surfaces (the Albedo effect). 

PV arrays and irradiance sensors can pick up significant amounts of irradiance reflected off of 

surrounding surfaces. Examples of albedo effects include reflections from adjacent roof 

surfaces, building walls, and other PV arrays. The strength of the albedo effect is not as much a 

function of the perceived color of the surface as one might think. Even the surface of a 

blacktop parking lot reflects substantially. 

If the array under test is located in a built-up environment with lots of reflective surfaces, there 

is not much you can do about it, other than to select an irradiance sensor location that 

represents the typical irradiance conditions. Of course, the I-V curve measurements register 

the albedo effects. This is another reason to conduct important performance measurements in 

the central 4 hours of the day when albedo effects are likely to be minimized in relation to the 

direct irradiance. 

Manual Irradiance Sensor Is Not Accurate

Hand-held irradiance sensors vary widely in their calibration accuracy, response to off-angle 

light, and spectral match to the array measured. All of these variables affect accuracy.
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Low Voltage

An example of this type of deviation is in Figure Figure 18.

Figure 18. Measurement with a Lower than Predicted Voc

PV Cell Temperature Measurement Is Incorrect

The module Voc depends on the temperature of the solar cells. Higher temperatures result in a 

lower Voc. It is possible that a poor thermal connection exists between the thermocouple and 

the back of the module leading to a temperature measurement error. 

Also, if two thermocouples are plugged into SolSensor and only one of them is attached to the 

back of a module this can cause a temperature measurement error because, the Software 

averages the two thermocouple temperatures. 

Placement of the thermocouple is also important. It should be placed at a location that 

represents the average temperature of the modules. Avoid the edges of the table/array 

because they run cooler due to better air circulation. 

One or More Bypass Diodes Are Shorted

This is a possible cause in single-string measurements. In parallel-string measurements it 

causes a step in the I-V curve.

Rounder Knee

An example of this type of deviation shows in Figure 19.
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Figure 19.  I-V Curve Measurement of Rounder Knee than Predicted by the PV Model

Rounding of the knee of the I-V curve can be a manifestation of the aging process. This effect 

is rarely seen alone, and is usually a side-effect of changes in the slopes of the legs of the 

curve.

Steeper Slope in Horizontal Leg

An example of this deviation is shown in Figure 20.

Figure 20. I-V Curve with a Steeper Slope in the Horizontal Leg of the I-V Curve
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The horizontal leg of the I-V curve may exhibit a steeper slope than the PV model predicts. 

Potential causes of this deviation are summarized below, and then discussed in more detail:

 Tapered shade or dirt dams

 Module Isc mismatch 

 Shunt paths exist in PV cells

Tapered Shade or Dirt Dam Across All Cell Groups 

A tapered band of shade or dirt across the all cell groups can cause the steeper slope in the 

horizontal leg of the curve.

Increased Shunting in PV Cells

Shunting is the flow of PV current backwards across the cell junction. This is a current loop 

internal to the cell, which subtracts from the current that it is able to contribute to the string. 

Some amount of shunt current within a solar cell is normal, and is the cause of the slight slope 

in the horizontal leg of the curve. However, if the shunt resistance of cells degrades to a lower 

value across the array, the slope of the horizontal leg becomes steeper. 

Localized shunt failures cause local heat dissipation and can lead to runaway thermal failures 

of the cell and module.

Less Steep Slope in Vertical Leg

An example of this type of deviation is shown in Figure 21.

Figure 21. Measurement with Less Steep Slope in the Vertical Leg of the I-V Curve
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The slope of the vertical leg of the I-V curve is affected by the amount of series resistance 

internal to the PV modules and in the array wiring. Increased resistance reduces the steepness 

of the slope and decreases the fill factor. 

Potential causes are summarized below, and then discussed in more detail:

 PV wiring has excess resistance or is insufficiently sized.

 Electrical interconnections in the array are resistive.

 Series resistance of PV modules has increased.

PV Wiring Has Excess Resistance 

During setup of the Project in the Software, the user enters the length and gauge of the 

external, string-related wiring, most commonly the home-run cabling to a combiner box. 

During measurements, the PV model uses this information to account for expected voltage 

and power loss in this external wiring, so that it is not associated with the performance of the 

PV modules. The wire length does not include the length of the cords of the modules 

themselves. A major difference between entered and actual wire length can introduce excess 

resistance. For example, 500 ft (1-way) of #10 wire will add approximately 1 Ω of series 

resistance. This would reduce the slope in the vertical leg of the predicted I-V curve near Voc. 

The resistance of the test leads of the I-V Curve Tracer is extremely low and can be neglected.

Electrical Connections in the Array Are Resistive

Electrical connections anywhere along the current path can add resistance to the circuit. 

Assure that connectors between modules are fully inserted. Also check for signs of corrosion 

in J-boxes and combiners.

Series Resistance of PV Modules Has Increased

Certain degradation mechanisms can increase the amount of series resistance of a particular 

module. Corrosion of metal terminals in the module connectors, in the module junction box, or 

on the interconnects between cells may increase series resistance.

Troubleshoot PV Arrays

For a detailed article on how to interpret I-V curve deviations, see the SolarPro article, Solar I-V 

Curves--Interpreting Trace Deviations. 

Translation of I-V Data to Standard Test Conditions

The Software provides a feature to translate the displayed I-V curve to Standard Test 

Conditions (STC) of 1000W/m2 and 25 °C. The Software also translates the key performance 

parameters in the Table view (tab). 
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The primary application for these features is the analysis of I-V data collected during the 

commissioning of commercial scale PV arrays. As these measurements are usually done in a 

4-hour span centered about solar noon, the measured I-V curves reflect the changes in 

irradiance and cell temperature that take place over this time period. The translation features 

remove these effects to a first order by translating key performance parameters derived from 

the I-V curves to STC conditions. Fast changes in irradiance and temperature caused by 

rapidly moving clouds will be difficult to correct accurately, so clear days are still required for 

quality end results. 

Translation introduces error in proportion to the span of the translation. Take this into account 

when you assess the consistency of performance across a population of PV strings. 

Parameter Definitions

These definitions are extracted from the Sandia PV Array Model (D. L. King) paper: 

Isc = Short-circuit current (A) 

Imp = Current at the maximum-power point (A) 

Vmp = Voltage at maximum-power point (V)

Voc = Open-circuit voltage (V) 

Pmp = Power at the maximum power point (W)

αIsc = Normalized temperature coefficient for Isc, (%/°C). This parameter is normalized by 

dividing the temperature dependence (A/°C) measured for a particular standard solar 

spectrum and irradiance level by the module short-circuit current at the standard reference 

condition, Isco. Using these (%/°C) units makes the same value applicable for both individual 

modules and for parallel strings of modules. 

αImp = Normalized temperature coefficient for Imp, (%/°C). Normalized in the same manner as 

αIsc. 

βVoc, (%/°C) = Temperature coefficient for module open-circuit-voltage.

γmpp, (%/°C) = Temperature coefficient for module maximum power point voltage.

Tc = Cell temperature inside module in °C. Obtained by measuring the back-surface module 

temperature and adding the temperature differential (typically 2 degrees to 3 degrees, 

depending on irradiance levels). 
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Translation Equations

The basic translation model used here makes these approximations:

Pmp is proportional to E, the irradiance

Imp does not depend on temperature

Vmp is independent of E

Pmp varies with temperature according to γmpp. (taken from the data sheet)

Voc is independent of E

In light of these approximations, we make these assumptions: 

Isc scales directly with E and with temperature.

Voc varies linearly with temperature according to βVoc. 

Pmp scales with E and varies with temperature according to γmpp 

Vmp changes with temperature depending on γmpp only, since αImp is much smaller than αIsc 

and is assumed to be zero. 

The translation equations are as follows, where the subscripts are defined as m = measured, 

and trans = translated:

Isctrans = Iscmeas * (Etrans / Emeas) / (1 + (αIsc/100) * (Tmeas - Ttrans))

Voctrans = Vocmeas / (1 + (βVoc/ 100) * (Tmeas - Ttrans))

Imptrans = Impmeas * (Etrans / Emeas)

Vmptrans = Vmpmeas / (1+ (γmpp/ 100) * (Tmeas - Ttrans))

Pmptrans = Pmpmeas * [Etrans / Emeas] / (1+ (γmpp / 100) * (Tmeas - Ttrans)) 
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Maintenance

Clean the Product

WCaution

To prevent Product damage, do not use solvents or cleaners. These fluids can 

damage the Product.

To clean the I-V Curve Tracer, SolSensor outer case, and test leads wipe them with only a 

damp cloth and mild detergent.

Clean the SolSensor Irradiance Sensor

WCaution

To prevent irradiance sensor damage, do not use solvents or cleaners to clean 

the sensor. These fluids can cause micro-cracks in the material and reduce the 

accuracy of the irradiance measurement. Use only distilled water and a soft 

cloth. A soft microfiber cloth and a spray bottle of distilled water are supplied 

as standard equipment. 

To clean the irradiance sensor: 

1. Tip the SolSensor unit on its side so that the irradiance sensor faces horizontally. 

2. Spray the white acrylic disc with a fine mist of distilled water. 

3. Let the excess water run off, carrying dust and dirt with it. 

4. Dry the white acrylic disc with a soft, clean, dry cloth. Never use soap or chemical 

solutions or abrasive cloths. 

Product Disposal

Dispose of the Product in a professional and environmentally appropriate manner. If this 

Product has an integral battery, put the entire Product in the electrical waste.

Troubleshoot PVA Software Operation

This section describes steps to troubleshoot the operation of the Software. Troubleshooting 

of actual PV systems is not included in this discussion. 

For tips to set up Windows for compatibility with the Software, and to troubleshoot Windows, 

see the product page on the Fluke website. 

Troubleshoot with Status Messages

The main tool to troubleshoot Software operation is the Status indicator, shown on the upper 

right of the screen above the Measure Now button. See the green Ready message in Table 7 

for an example. See Table 20. 
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XWWarning

To prevent possible electrical shock, fire, personal injury, or death, pay attention 

to the Status indicator in the upper right of the Software. Click on the Status 

indicator in any state to get more information about the status. Note that the PV 

circuits continue to present danger of electrical shock regardless of the active, 

paused, or disabled state of the I-V Measurement Unit.

Table 20. Status Messages

Status Message Description

Ready
The wireless link to the I-V Curve Tracer is established and the 

equipment can now take a measurement.

Initializing
The link to the I-V Curve Tracer is established, and the Software is 

initializing the device.

Measuring
The I-V Curve Tracer is currently processing a measurement request 

and performing an I-V measurement.

Disabled

The I-V Curve Tracer has turned itself off because it detected one of 

these conditions listed below. Click the Disabled message and follow the 

instructions. See Software Overview.

I-V Measurement Unit battery voltage is too low:

The battery level is critically low, and the I-V Curve Tracer will now 

shut down. Recharge the battery before further use.

Current in excess of xxA was detected:

The maximum input current specification has been exceeded. If 
you will measure strings in parallel, reduce the number of parallel 

strings. 

Excess voltage was detected:

Voltage specification was exceeded. If the overvoltage is severe, 

the Software also permanently disables the I-V Curve Tracer. This 
condition requires the I-V Curve Tracer to be returned to the 

factory for inspection and repair.

I-V Measurement Unit is too hot:

I-V Curve Tracer internal temperature is too high and the 
protection circuit has shut it down. Move the I-V Curve Tracer to a 
cooler location out of the direct sun, and allow time for the 
temperature to drop.

Current overload pulse:

A significant current overload pulse was detected. Make sure the 

inverter or other parts of the array were not inadvertently 

connected during the measurement. Also, certain high efficiency 
PV modules generate a high in-rush current. When you use the 

PVA-1500T2, do not measure these types of modules in parallel 

or strings of high efficiency modules that are >10 A.
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Troubleshoot by Symptom

Table 21 shows symptoms and steps to troubleshoot the issue. 

Paused

The I-V I-V Curve Tracer has been temporarily stopped because you 

pushed the LED button. It is a normal part of the operation of the I-V 

Curve Tracer. In this condition, PV source connections may be changed 

without interruption to a measurement. To return to the normal state, 

push the LED button again. 

Searching for I-V 

Unit

The PC and Software has not yet connected with the Wi-Fi hotspot 

created by the I-V Curve Tracer. The I-V unit LED button blinks rapidly 

when it is not connected to the PC software with Wi-Fi. Make sure that 

the I-V unit is turned on and is within wireless range. 

No WiFi 

connection 

The PC Wi-Fi network adapter is turned off. Turns on the Wi-Fi adapter 

and connect to the PVA1500_yyyyyy hotspot.

Table 21. Troubleshoot By Symptom

Symptom or 

Message
Description and Remedy

SolSensor 

display area 

says searching 

for SolSensor 

or shows ----

With the SolSensor, these messages appear in the SolSensor data display 

area when the SolSensor does not have a wireless link to the I-V Unit. Make 

sure the SolSensor is on and that it is within wireless range. Obstructions in 

the line-of-sight can reduce wireless range. 

 If the SolSensor continues to fail to connect, perform a hard reset of the 

SolSensor and the I-V Unit. Hold down the power button for at least 

6 seconds on each.   

It is also possible that the SolSensor is not properly paired to the I-V unit. 

The SolSensor units are paired at the factory to the specific I-V unit that 

ships with your SolSensor. If you have a new SolSensor that was never 

paired to your I-V unit, or it has lost its pairing, it may be re-paired to the I-V 

unit with the steps in Operational States of the Table 3. 

Communication 

to I-V 

Measurement 

Unit or 

SolSensor 

Briefly Drops 

Out

A brief dropout can occur between the I-V Curve Tracer and PC. If the link 

does not restore in 2 minutes, you may be out of wireless range. Similarly, 

communication with SolSensor can also briefly drop out, but should 

restore momentarily if SolSensor and the I-V Curve Tracer are within 

wireless range of one another. If the I-V Unit is not wirelessly connected to 

the PC, the software shows Searching for SolSensor because SolSensor 

communicates through the I-V Curve Tracer to the PC.

Table 20. Status Messages (cont.)

Status Message Description



Solmetric I-V Curve Tracer  Kit

Maintenance

83

Symptom or 

Message
Description and Remedy

Measurements 

Take Longer to 

Save

The measurement save speed depends on the number of I-V trace points 

selected. Use 100 points for most work and 500 points when high 

resolution is required. The resolution can be changed back and forth any 

time throughout your Project. The resolution control is located in the 

Utility menu. 

The minimum time from measurement to measurement for the I-V Curve 

Tracer is also affected by the open circuit voltage of the strings under test. 

See Table 5.

I-V Curve Does 

Not Reach 

Down to the X-

axis

This type of trace may be seen if you have been measuring an I-V curve 

with a large step in the current.

Trace is Noisy

Noisy I-V curve traces can be a result of low irradiance, especially for PV 

technologies with low short circuit current. For best results, make 

measurements of fixed arrays during the hours of maximum irradiance. 

Strings of low Isc modules can be tested in parallel to increase current and 

reduce noise. In rare occasions, current spikes can appear in the I-V curve 

data, especially near Voc. This can indicate a problem in the modules or 

wiring such as an arc fault.

I-V Curve Drops 

to Zero Current 

at One or More 

Points

This condition can occur if there is an unstable electrical connection in the 

PV circuit being measured. This is not a problem with the I-V Curve Tracer. 

In stages, remove modules and cables from the PV source circuit to locate 

the unstable connection.

Short Circuit 

Current is Much 

Higher, or 

Lower, than 

Predicted by 

the Model

Make sure the irradiance sensor is mounted in the plane of the array. 

Check for array soiling. Make sure that the latitude, longitude, and azimuth 

are correctly entered on the Site Info screen, and that the PC date and 

time are correct. If you use a tracker, make sure the morning array azimuth 

is set correctly in the Site Properties of the PVA project in the Software. 

Table 21. Troubleshoot By Symptom (cont.)
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For further troubleshooting information, see the poster that shipped with the Product that is 

also available at fluke.com.

Symptom or 

Message
Description and Remedy

Unstable 

Voltage 

Message

Before you do a sweep, the PVA measures Voc 10 times to get an average 

value. If there is a large variation of values across these 10 measurements, 

the Software posts a warning. Check for poor connections anywhere in the 

measurement loop. 

I-V Curve 

Tracer Cannot 

be Turned On

Check that the I-V Curve Tracer is charged. 

Zero Current 

for Entire I-V 

Curve

The I-V Curve Tracer contains a thermal fuse set to trip if the inside of the I-

V Curve Tracer exceeds 85 °C. This is an uncommon occurrence because 

the software is programmed to dis-allow measurements when the internal 

temperature exceeds approximately 72 °C. However, if the thermal fuse 

trips, it irreversibly shuts down the I-V Curve Tracer and requires a return 

to the factory. If you suspect that this has occurred, contact Fluke. See 

Contact Fluke.

Table 21. Troubleshoot By Symptom (cont.)
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